RENESANS Application Note

Renesas RA Family
Security Design using Arm TrustZone - Cortex M85

Introduction

The Renesas RA8 MCU Series has a Cortex-M85 core and implements Armv8.1-M architecture. This MCU
Series includes the Armv8-M Security Extension, which provides a foundation for improved system-level
security in a wide range of embedded applications. This application note explains the various RA8 MCU
TrustZone technology enabled hardware and software features and provides guidelines for using these
features. In addition, this application project provides step-by-step instructions to kickstart TrustZone
technology enabled secure system design with Renesas RA8 Family MCUs.

For fundamentals of Arm TrustZone Technology, users are encouraged to read the document Arm®
TrustZone Technology for the Armv8-M Architecture from Arm. This application project focuses on the
TrustZone technology implementation and features for RA8 Family MCUs with TrustZone support. At the
time of release, the RA8 MCU groups that are covered by this application project include the MCU groups
with support for both TrustZone and Device Lifecycle Management. Support for the RA Cortex-M33 MCU
TrustZone and Device Lifecycle Management, please refer to R11AN0467.

Creating a secure design involves using hardware enforced isolation to create a software architecture
specifically designed for security, supported by MCU tooling. For TrustZone based security design, tooling
plays a critical role for the development, production, and deployment of a product. For the tools support, refer
to the FSP User’s Manual section: Primer: TrustZone Project Development prior to proceeding to TrustZone
based development.

An EK-RA8M1 based application project implementing an IP protection use case for TrustZone technology is
provided as a reference project to start application development with the RA Family MCU TrustZone feature.
Implementations with e? studio, IAR EWARM, and Keil MDK IDEs are provided with instructions on how to
import and run the example projects.

Required Resources

Target Devices

¢ RA8BM1
¢ RA8D1
e RAS8T1
¢ RASE1l
e RAS8E2

Software and development tools

e? studio IDE v2024-10

e Renesas Flexible Software Package (FSP) v5.6.0
¢ Renesas Advanced Smart Configurator v5.6.0

¢ Renesas Advanced Smart Configurator v2024-10

The links to download the above software are available at https://github.com/renesas/fsp.
¢ |AR Embedded Workbench for Arm version v9.60.2
(https://www.iar.com/products/architectures/arm/iar-embedded-workbench-for-arm/)
e Keil MDK v5.41
(https://www.keil.com/download/product/)
e SEGGER J-Link® USB driver v7.98g (SEGGER J-Link)
e Renesas Flash Programmer (RFP) v3.17.00

Hardware
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e EK-RA8ML1, Evaluation Kit for RABM1 MCU Group (renesas.com/ra/ek-ra8m1)
e  Workstation running Windows® 10 and the Tera Term console or similar application
e One USB device cable (type-A male to micro-B male)

Prerequisites and Intended Audience

This application project assumes that you have some experience with the Renesas e? studio IDE, IAR
EWARM, or Keil MDK IDE. In addition, the user is expected to understand how to extract the generated
content from the FSP and the Renesas RA Smart Configurator. It is also recommended to read the first two
chapters of the application note R11AN0785 (Device Lifecycle Management for RA8 MCUSs) to understand
the Device Lifecycle States for RA8 MCUSs. Furthermore, users must know how to enter MCU boot mode
using the EK-RA8M1 and create a basic RFP project to communicate with the MCU. This application project
only provides necessary settings for the specific functions used in this application project. For more
information on the MCU boot mode and RFP, refer to the Renesas RA8M1 Group User’'s Manual: Hardware
and Renesas Flash Programmer User’'s Manual.

The intended audience is all users who are or will be developing Arm® TrustZone® based applications using
Renesas RA8 Family MCUs.
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1. Introduction to Arm® TrustZone® and its Security Features

1.1 TrustZone Technology Overview

Arm TrustZone technology is a hardware-enforced separation of MCU features. Arm TrustZone technology
enables the system and the software to be partitioned into Secure and Non-secure worlds. Secure software
can access both Secure and Non-secure memories and resources. Secure software must use Secure
transactions to access Secure memory and resources. Secure software must use Non-secure transactions to
access Non-secure memory and resources. Non-secure software can only access Non-secure memories
and resources using Non-secure transactions. Non-secure software cannot access Secure memory and
resources. Refer to Figure 3. for the definition on Secure Transaction and Non-secure Transaction. These
security states are orthogonal to the existing Thread and Handler modes, enabling both Thread and Handler
mode in both Secure and Non-secure states.

Processor States

Thread mode Thread mode

Handler mode Handler mode

Figure 1. Processor States

The Armv8-M architecture with Security Extension is an optional architecture extension. If the Security
Extension is implemented, the system starts up in the Secure state by default. If the Security Extension is not
implemented, the system is always in the Non-secure state. Arm TrustZone technology does not cover all
aspects of security; for example, it does not include cryptography.

In applicationss with Armv8-M architecture with Security Extension, components that are critical to the
security of the system can be placed in the Secure world. These critical components include:

e A Secure boot loader

e Secret keys

e Flash programming support
e High value assets
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The remaining components in an application are placed in the Non-secure world.

Non-trusted

Secure Services
Firmware
Secure Firmware
Data Secure Data

Peripherals

Memory

CPU Resources

Debug

Figure 2. Secure and Non-secure Worlds

As mentioned in the Introduction section, for more details on the definition and usage of TrustZone®, see the
Arm document, Arm TrustZone Technology for the Armv8-M Architecture.

1.2 RA8 MCU Arm TrustZone Security Attribution

This section introduces how the TrustZone security attribution is defined and used on the RA Cortex-M85
MCUs. FSP does all of the configuration and transaction handling in the background. Configuring the
TrustZone attribution does not need handling from the user application code when using FSP. This section is
provided for your reference. Skip to section 2 to start developing TrustZone based applications using RASC
and FSP.

The TrustZone for Armv8.1-M implementation consists of the Security Attribution Unit (SAU) and
Implementation Defined Attribution Unit (IDAU). The 4 GB memory space is partitioned into Secure (S) and
Non-secure (NS) memory regions. The secure memory space is further divided into two types, Non-secure
Callable (NSC) and Secure.

In this Application Note, Secure Transaction and Non-secure Transaction are defined as follows. These
concepts are used throughout the rest of the Application Note:

e Secure Transaction: Access transaction that is issued with bit 28 in the address set to ‘0.
¢ Non-secure Transaction: Access transaction that is issued with bit 28 in the address set to ‘1’.

Note that the physical address of the RA8 MCU is a continuous region. When bit 28 is manipulated to form a
Secure or Non-secure transaction, we refer to this updated address as the Alias address of the memory
area. Refer to section 1.2.5 for a pictorial memory map representation of the Alias memory map example for
the code and data flash in linear and dual bank modes.

On RA8 MCUSs, the secure region can successfully issue both Secure and Non-secure transactions, but the
non-secure region can only successfully issue Non-secure transactions. Figure 3. Figure 3 illustrates what
transactions are allowed by the TrustZone filter.
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Secure transaction: Access transaction issued with bit 28 in the address set to ‘0",
Non-secure transaction: Access transaction issued with bit 28 in the address set to ‘1’
: TrustZone error generated.

IDAU+SAU for CPU Access address Trust Zone

MSAU for other bus masters ~ Security attributes Filter

Secure Transaction

1 1
1 1
1 1
1 1
1 1 >
T T >
1 . 1
, Non-secure Transaction ' Secure
1 L > ® Slave
1 1
1 1
1 .
SEEIE | Secure Transaction :
master ) > ®
| ' Non-secure
! ) ! Slave
: Non-secure Transaction !
1 >
T ] >
] 1
,,,,,,,,,,, I S | I R
1 1
: Secure Transaction :
T T > ® Secure
] . 1
1 Non-secure Transaction 1 Slave
Non- . > @
1 ]
secure | |
master : Secure Transaction :
T : > ® Non-secure
1 . 1
\ Non-secure Transaction \ Slave
1 1 i
) 1

Figure 3. Transactions that Can be Issued by Each Master

1.2.1 Implementation Defined Attribution Unit (IDAU)
The IDAU defines the code, SRAM, and peripherals into the secure region and the non-secure region.

Portions of the secure code region and secure SRAM region can be assigned with the NSC security
attribute. The defined security map enforced by the IDAU is set in hardware and cannot be changed by
software.

For the code flash, one secure and one non-secure region can be defined in linear mode. In dual bank
mode, each bank can have one secure and one non-secure region. For the data flash, the SRAM and the
Standby SRAM, there can be one secure and one non-secure region. The external memory CS area
controller (CSC), the SDRAM region, and the OSPI region on the RA8 MCUs are always configured as non-
secure. Application code cannot change these secure properties.
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IDAUMSAL
Address Map Security_Attribution
0xFFFF_FFFF
Arm® Cortex®-M85
0xE010_0D00O0
Private peripheral bus
0xE000_0000
— |
Reserved area*?
0xAD00_D000
External address space
(OSPI area)
Non- 0x8000_0000
secure 0x7000 0000 Reserved area*?
Alias _< N External address space Nen-
Addresses 0x6800_0000 (SDRAM area seare
. X External address space
Bit28is 1 0x6000_0000 (CS area)
Reserved area*?
0x5050_0000
0x5020 0000 Peripheral I/O registers
Reserved area*?
0x5012_0000
0x5010 0000 Flash VO registers
_ Dx500070000 Peripheral I/O registers
Reserved area*?
0x4050_0000
iﬁ;:re 0x4020 0000 Peripheral /O registers
- Secure
Addresses 0x4012_0000 e
Bit 28 is 0 0x4010_0000 Flash O registers
0x4000 0000 Peripheral /O registers
— - 2
0x3703_0400 Reserved area®
0x3703 0050 | On-chip flash (option-setting memaory)
- w2
Non- 0x3700_3000 Reserved area
secure 0x3700_0000 On-chip flash (data flash)
Alias _J 0x3600 0400 Reserved area™ Nom-
Addresses 0x3600_0000 Standby SRAM secure
o 0x320E_0000 Reserved area*?
Bit28is 1 0x3200_0000 On-chip SRAM
0x3001_0000 Reserved area*?
~— 0x3000_0000 DTCM -
— 0x2703_0400 Reserved area
0x2703 0050 | ©n-chip flash (option-setting memory)
- 2 Non-
Secure 0x2700_3000 Reserved area o
Alias ox2700_ongo | On-ohip flash (data flash) callable
Addresses | __J  ox2600_0400 Feai i for CPU
0x2600 0000 Standby SRAM cecure
i i - *2
Bit28is 0 0x220E_0000 e e for other
0x2200_0000 On-chip SRAM bus .
0x2001_0000 Reserved area*? masters
“— 0x2000_0000 DTCM
Reserved area*?
0x1300_A300
0x1300_A100 | On-chip flash (option-setting memory)
Non- 0x1300_8184 Reserved area?

On-chip flash (Factory Flash) Non-
secure 0x1300_80F0 Z Non-
Alias — 0x122F_8000 Reserved area
Addresses On-chip ﬂagn {?ojg? flash)

read on
Bit 28 is 1 0x1200_0000 Y
1t28is Reserved area*?
0x1001_0000
"~ 0x1000_D00O ITCM
Reserved area*?
 0x0300_A300 Mon-
0x0300_A100 | On-chip flash (option-setting memory) secure
liabl
Secure 0x0300_B1B4 Reserved area* 'ﬂgr ﬂc PS
Alias Ox0300_A0F0 On-chip flash (Factory Flash)
Addresses = =
—J 0x022F_8000 Sl Secure
Bit28is 0 On-chip flash {cm?e flash) bus
(read only)*!
0x0200_0000 masters
Reserved area*?
0x0001_0000
L 0x0000_0000 ITCM

Figure 4. RA8M1 Memory map example of 2 MB flash product

R11ANO897EU0100 Rev.1.00 Page 9 of 75
Nov.13.24 RENESAS




Renesas RA Family Security Design using Arm TrustZone - Cortex M85

Code and Data Flash TrustZone® Based Security Features

Code and Data secure flash regions read from a Non-secure region will generate a TrustZone Secure Fault.
Per the MCU design, the Code and Data Flash Programming and Erasing (P/E) mode entry can be
configured to be available from only Secure software. The secure region can be accessed by the Non-secure
region through Non-secure callable functions. For example, the flash driver may be placed in the Secure
partition and may be configured as Non-secure Callable through the FSP to allow the Non-secure application
to perform flash P/E operations.

Table 1. Secure Flash Region Read/Write Protection

Access Violation
Flash read
Flash P/E mode entry

Error Report
TrustZone Secure Fault: Reset or Non-Maskable Interrupt (NMI).
Flash P/E Error Flag: Handled by FSP flash driver.

RA8 Family MCUs support temporary and permanent Flash Block Protections for both the Secure region and
the Non-secure region. For more details on the Code and Data Flash TrustZone technology enabled
hardware features, see the Renesas RA8M1 Group User’s Manual: Hardware, Flash Memory section.

SRAM

SRAM memory, such as SRAMO, that includes an ECC region and Parity can be divided into Secure/Non-
secure Callable/Non-secure regions with Memory Security Attribution (MSA) and can be protected from Non-
secure access. When MSA indicates that an SRAM memory region is of Secure or Non-secure Callable
status, Non-secure access cannot overwrite that memory.

Table 2. Secure SRAM Region Read/Write Protection

Access Violation
SRAM read
SRAM write

Error Report
Arm® TrustZone Secure Fault: Reset or NMI
Arm TrustZone Secure Fault: Reset or NMI

1.2.2 Master Security Attribution Unit (MSAU)

The MSAU defines the system-specific security address map for bus masters other than the CPU. The
MSAU defines secure and non-secure alias regions; it does not define Non-secure Callable (NSC) regions or
region number. Bus masters other than the CPU can issue a security transaction using the secure alias
address defined by the MSAU. However, non-secure masters are prohibited from issuing secure transactions
using an address in the secure alias region. The defined security map is enforced by the MSAU is fixed in
hardware and cannot be changed by software.

Although the security map as defined by the IDAU and the MSAU is fixed, the SAU can be used to vary the
security attributions of the regions following the rules defined in section 1.2.3.

Address
map

Address
map

Security Attribution
partition

Security Attribution
partiion

Address Address

OXFFFF_FFFF[ | o OXFFFF_FFFE | Vendor s¥s

Exempt Exempt

0xE000_0000 PPB 0xE000_0000 | PP

0xC000_0000 External

0xC000_0000
- Device

External
Device

0xA000_0000 NS 0xAD00_0000 NS

0x8000_0000

0x6000_0000

0x4000_0000

0x2000_0000

0x0000_0000

External
RAM

Peripheral

Address bit [28]
1 N e

0 : Secure or NSC

Caode

IDAU

0x8000_0000

0x6000_0000

External

0x4000_0000

0x2000_0000

Peripheral

NS

SRAM

NS

0x0000_0000

NS

MSAU

Address bit [28]
— 1 : Non-secure
0 : Secure

Figure 5.

IDAU and MSAU defined security map
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1.2.3 Security Attribution Unit (SAU)

The SAU is a programmable unit that determines the security of an address. The SAU is programmable in
the Secure state and has a programmer’s model similar to the MPU. If an address maps to regions defined
by both IDAU and SAU, the region of the highest security level is granted. A secure master can issue secure
and non-secure transactions using the address of each security alias region. A non-secure master cannot
issue secure transactions using the address of the secure alias region.

When using TrustZone to perform secure and non-secure region separation, the SAU MUST be set
according to the following.

The regions set as NS attribute in IDAU MUST be set to NS in the SAU as well. The regions set to NS
attribute in IDAU are:

0x1000_0000 to 0x1FFF_FFFF (SAU Region 1 in Figure 6Figure 6. )
0x3000_0000 to Ox3FFF_FFFF (SAU Region 3 in Figure 6)
0x5000_0000 to OXDFFF_FFFF (SAU Region 3 in Figure 6Figure 6. )

At least one NSC region MUST be created within any region defined as NSC by the IDAU. The regions set to
NSC attribute by the IDAU are:

0x0000_0000 to OXOFFF_FFFF (SAU Region 0 in Figure 6)
0x2000_0000 to Ox2FFF_FFFF (SAU Region 2 in Figure 6)
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0xE000_0000

0xC000_0000

0xA000_0000

0x8000_0000

0x6000_0000

0x4000_0000

0x2000_0000

0x0000_0000

External
Device
NS
NS
External
RAM
Peripheral
)
SAU Region 3
/ (required)
NS
SAU Region 2
SRAM s / (optional)*
NSC NSC
S SAU Region 1
/ (required)
NS NS
Code SAU I_?egior: 0
S / (optional)
NSC NSC
S
Memory map IDAU + SAU =

NS

NS

S

NSC

S

NS

S

NSC

S

Security Attributes

* Requires at least one NSC area

1.2.4 Region Number

Figure 6. SAU settings and resulting security attributes

The IDAU also defines region numbers for each of the memory regions and security attributes. This region
number is used by software to determine if a contiguous range of memory shares common security
attributes. Figure 7 shows the defined region number of IDAU.
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Security Attribution Region
Address Address map partition number
OxFFFF_FFFF Vendor SYS
Exempt 0
0xE000_0000 Pre
0xC000_0000 External
Device
0xA000_0000 NS
6
0x8000_0000 External
RAM
0x6000_0000
NS
Peripheral
0x4000_0000 S °
NS 4
SRAM
NS
0x2000_0000 C 3
NS 2
Code
0x0000_0000 NSC !

Figure 7. IDAU defined region numbers

1.2.5 Memory Security Attribution of TrustZone Filter

The memory security attribution of code flash and data flash is stored into nonvolatile memory by a boot
firmware command when the device lifecycle is in the OEM state and the authentication level is AL2. These
memory security attributions are applied before application execution. They cannot be updated by the
application but are readable using dedicated registers. The memory security attributions of SRAM, standby
SRAM, and VBATT backup registers are set by a dedicated security attribution register writable only by
secure access.

The code flash can be divided into up to two regions in linear mode and four regions in dual mode. The
partitioning is the same between bank0 and bankl in the dual mode. The data flash can be divided into up to
two regions. SRAM, standby SRAM, and VBATT backup registers can be divided into up to two regions.
Figure 8 shows the memory mapping. Figure 9 shows the size of the memory region.
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Figure 8. Memory mapping
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Memory region

Start address

Size

Linear mode Code flash secure 0x0200_0000 CFS2 size (32 KB)
Code flash non-secure 0x1200_0000 + CFS2 size (32 KB) Code flash size - CFS2 size (32 KB)
Dual mode Code flash bank0 secure 0x0200_0000 CFS2 size (32 KB)

Code flash bank0 non-secure

0x1200_0000 + CFS2 size (32 KB)

Code flash size/2 - CFS2 size (32 KB)

Code flash bank1 secure

0x0220_0000

CFS2 size (32 KB)

Code flash bank1 non-secure

0x1220_0000 + CFS2 size (32 KB)

Code flash size/2 - CFS2 size (32 KB)

Data flash secure

0x2700_0000

DFS size (1 KB)

Data flash non-secure

0x3700_0000 + DFS size (1 KB)

Data flash size - DFS size (1 KB)

SRAMO secure

0x2200_0000

BA (8 KB)

SRAMO non-secure

0x3200_0000 + BA (8 KB)

SRAMO size - BA (8 KB)

SRAM1 secure

0x2206_0000

BA (8 KB)

SRAM1 non-secure

0x3206_0000 + BA (8 KB)

SRAM1 size - BA (8 KB)

Standby SRAM secure

0x2600_0000

BA (128 bytes)

Standby SRAM non-secure

0x3600_0000 + BA (128 bytes)

Standby SRAM size - BA (128 bytes)

VBATT backup register secure

0x4001_EDOO

BA (32 bytes)

VBATT backup register non-secure

0x5001_EDOO + BA (32 bytes)

Backup register size - BA (32 bytes)

Note:

The number in parentheses indicates the smallest unit that can be set by the user.

Figure 9. Size of memory region

Note: BA is the setting of the security attribution boundary address register for each memory region.

It is prohibited to place Secure or Non-secure Callable regions in a block swappable area in linear mode
because the secure application would be placed in the non-secure region after block swapping.

The contents in Secure or Non-secure Callable regions must be the same in both bank0 and bank1l in the
dual mode. Otherwise, the contents of secure or non-secure regions may not be consistent after a field

update.

Table 3 is a summary of the memory access and error reporting for TrustZone based application based on
the definition of Secure Transaction and Non-secure Transaction defined in Figure 2.

Table 3. Access Permission and Error Reporting of the Memory Region

Memory Region

Secure Transaction
Targeting Secure
Memory Regions

Secure Transaction
Targeting Non-secure
Memory Regions

Non-secure Transaction
Targeting Secure
Memory Regions

Non-secure
Transaction
Targeting Non-
secure Memory

configured as NS

Write/Read ignored.
TrustZone access
error is generated.

ignored. TrustZone
access error is
generated.

ignored. TrustZone access
error is generated.

Regions
Each memory region Allowed. Not Allowed. Write/Read | Not Allowed. Write/Read Allowed.
configured as S or NSC ignored. TrustZone ignored. TrustZone access
access error is error is generated.
generated.
Each memory region Not allowed. Not Allowed. Write/Read | Not Allowed. Write/Read Allowed.

1.2.6 Peripheral Security Attribution of TrustZone Filters
Each peripheral can be configured as secure or non-secure. Peripherals are divided into two types.

Typel peripherals have one security attribution. Access to all registers is controlled by one security
attribution. The Typel peripheral security attribution is written to the PSARX (x = B to E) register by the
secure application.
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Type2 peripherals have security attribution for each register or for each bit. Access to each register or bit
field is controlled according to these security attributions. Type2 peripheral security attributions are written to
the Security Attribution register in each module by the secure application.

For details on the Security Attribution register, see the corresponding sections in the Hardware User’s
Manual. e? studio and the FSP provide configurability for most of these peripherals with several exceptions
where sensible default settings have been made to provide a better development experience. See the latest
ESP User’s Manual for details for each peripheral.

Table 4. List of Type-1 and Type-2 Peripherals

Peripheral

SCI, SPI, OSPI, DOTF, ETHERC, EDMAC, USBHS, USBFS,

IIC, I3C, RSIP-E51A, CANFD, CEU, DOC, SDHI, SSIE, CRC,

CAC, ACMPHS, TSN, ADC12, DAC12, POEG, AGT, GPT,

ULPT, RTC, IWDT, and WDT

System control (Resets, PVD, Clock Generation Circuit, Low Power
Modes, Battery Backup Function), Flash memory controller, Flash
cache, SRAM controller, CPU cache, DMAC, DTC, ICU, MPU, BUS,
Security setting, ELC, and 1/O ports

Type
Type 1

Type 2

Notes on Clock Generation Circuit (CGC)

The Clock Generation Circuit has individual security attributes for each of the clock tree controls. The current
release of the tooling and FSP provides flexibility of the following clock control schemes:

o Entire clock tree is controlled from the Secure project only and locked down in the Non-secure project.
e Entire clock tree is controllable from the Non-secure project as well as the Secure project.

Refer to Notes on Clock Control for the operational details.

Error! Reference source not found. is a summary of the memory access and error reporting for TrustZone
based application based on the definition of Secure Transaction and Non-secure Transaction defined in
Figure 2.

Table 5 Access Permission and Error Reporting for Type 1 Peripherals

Peripherals

Secure Transaction
Targeting Secure

Secure Transaction
Targeting Non-secure

Non-secure Transaction
Targeting Secure

Non-secure
Transaction

as NS

Write/Read ignored.
TrustZone access
error is generated.

ignored. TrustZone
access error is
generated.

ignored. TrustZone access
error is generated.

Peripherals Peripherals Peripherals Targeting Non-
secure Peripherals
Peripheral configured Allowed. Not Allowed. Write/Read | Not Allowed. Write/Read Allowed.
asS ignored. TrustZone ignored. TrustZone access
access error is error is generated.
generated.
Peripheral configured Not allowed. Not Allowed. Write/Read | Not Allowed. Write/Read Allowed.

1.3 Device Lifecycle Management and Debugging

The RA8 Family TrustZone technology enabled MCUs to incorporate an enhanced Device Lifecycle
Management System using TrustZone technology features and Renesas Secure IP (RSIP). Device Lifecycle
Management is important during TrustZone technology enabled application development, production, and

deployment stages.

For the Arm® TrustZone® technology enabled RA8 Family MCUs, the debug capability is determined by the
OEM Authentication Level (AL). The AL levels can be configured in three levels (ALO, AL1, and AL2) to
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support TrustZone technology enabled debugging and provide security in development, production, and
deployed products:

e AL2: Non-secure and secure debug functions are enabled and accessible from the debugger.

e AL1: Only non-secure debug function is enabled, and the debugger can access only defined non-secure
debug accessible regions.

e ALO: No debug functions are available.

Debug level regression is possible through the Device Lifecycle Management system. See the application
note R11ANO0785 for the corresponding operational flows. For creation, injection, and use of the Device
Lifecycle Management keys during development and production stages, see the Application Note
R11ANOQ785.

For Renesas RA TrustZone technology enabled MCUs, DLM usage with J-Link, E2, and E2 Lite debuggers
are supported.

1.4 Example TrustZone Use Cases

This application project explains two specific use cases for TrustZone technology and provides an example
software project for the IP Protection use case.

For additional attack scenarios where an attacker may attempt to access protected information and how the
TrustZone technology for ARMv8-M can prevent them, see Chapter 2, Security of Arm® TrustZone
Technology for the Armv8-M Architecture.

1.4.1 Intellectual Property (IP) Protection

IP protection is a common need for proprietary software algorithms and data protection. TrustZone
technology provides good hardware isolation for IP protection. TrustZone technology creates separation
between two regions: Secure (“trusted”) and Non-secure (“non-trusted”) code/data. Users who create
building blocks for others to integrate can take advantages of the TrustZone technology feature by storing
their software IP in the Secure (“trusted”) region.

Business Model

Not all software developers create end products. Some create building blocks, such as algorithms, for others
to integrate into an end product. One difficulty they face is the protection of their software IP. Their end
customers would prefer to receive source code, but source code can easily be copied and redistributed.
Even binary libraries are not complete protection, as there are tools that can disassemble binaries to
assembly and even C source code.

TrustZone® technology enables new business models for these developers in which they can program their
algorithms into the secure region of a TrustZone-enabled MCU and sell a value-added MCU, with their IP
protected by TrustZone and the Device Lifecycle Management (DLM) system of the RA MCU.

RA MCU Device Lifecycle Management Feature for IP Protection

During development, DLM state regression allows erasing the protected areas of flash (unless permanently
locked). This prevents reading of the protected area of the flash and hence protects the IP and eliminates
scrappage of devices in case the algorithms need to be modified.

In production, if the algorithm developer would like to retain the potential to debug algorithms with the
application in place, they can install DLM Authentical Level keys for the ALO/AL1 to AL2 and ALO to AL1
transitions.

RA MCU Flash Block Locking Feature for IP Protection

RA MCUs supports temporary and permanent Flash Block Protections. This allows customer IP and Root of
Trust to be protected from accidental erasure and alteration.

IP Protection Development, Production and Deployment Flow
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Figure 10. IP Protection using Arm® TrustZone®

Designing for IP protection uses the Split Project Development model. See section 4.2 for the operational
details.

1.4.2 Root of Trust Protection

The Root of Trust (RoT) is a product’s security foundation. All higher-level security is built on top of the RoT.
The RoT also implements recovery features for higher-level security breaches. When Root of Trust is
breached, recovery is not possible and can lead to serious consequences. For IoT applications, Root of Trust
may encapsulate authenticated firmware updates and secure internet communication.

To reduce the attack surface, the functionality included in the RoT should be as little as possible. Typical
services in the RoT are described in Figure 11.

+ Factory keys

» Device identity Root of Trust

Firmware Verification

+ Checksum/hash calculation on start-up e T

+ Image verification Services

+ Flash reprogramming e Flash and RAM
’ Peripherals

« Crypto services
+ Timer services

+ Key/certificate and sensitive data storage
« Secure world stack

+ None

Figure 11. Root of Trust Protection — Put as Little as Possible in the Secure Region

All other application code and device drivers should be considered for allocation to the Non-secure region. If
these other application code and device drivers access sensitive data or include IP algorithms, they can also
be allocated to the secure region.

2. Arm® TrustZone® Application Design Support

This chapter introduces several IDE features that are established to simplify software development when
using the TrustZone hardware isolation with support from other MCU hardware components, FSP software,
or tooling.

2.1 Renesas Advanced Smart Configurator

Renesas RA Smart Configurator (RASC) is a desktop application that allows the creation of projects for third-
party IDEs and allows the configuration of the software system (BSP, drivers, TrustZone, RTOS and
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middleware) for Renesas RA microcontrollers. The RASC implements a project generator, which allows
TrustZone and Non-TrustZone template projects to be conveniently generated.

2.1.1 Using RASC with Renesas e? studio
RASC is natively integrated with Renesas e? studio IDE.

Section 4 explains how to use the Smart Configurator to start TrustZone development.

2.1.2 Using RASC with IAR Embedded Workbench for Arm

Create the initial secure project using RASC and choose IAR Compiler. This process will generate the initial
secure project for IAR EWARM. Once the initial IAR EWARM project is generated, user can open this project
from the IAR EWARM IDE.

Next, user should follow the rasc_quick start.html file which is installed under \<RASC
installation root>\eclipse\.Referto rasc gquick start.html section Adding tools to a third-
party IDE to integrate RASC and the Renesas Device Partition Manager (RDPM) into the IAR EWARM IDE.

Once RASC is integrated in IAR EWARM, you can open RASC within the IAR EWARM IDE to further
develop the TrustZone based secure and non-secure project application project following the operations
explained in section 4.

2.1.3 Using RASC with Arm Keil MDK

The operation of using RASC and the RDPM with Arm Keil MDK to create TrustZone based application is
identical to the development process for using RASC with IAR EWARM in terms of the general flow. Section
5.6.2 demonstrated the usage of RASC as well as the RDPM.

2.2 Transitioning from CM State to OEM_PL?2 State

There are some prerequisites prior to setting up the MCU TrustZone boundary. From the factory, RA MCUs
are delivered to the developer in CM (Chip Manufacturing) or OEM_PL2 lifecycle state. If the MCU is
delivered in CM state, the MCU must be transitioned to OEM (Original Equipment Manufacturer) lifecycle
state prior to setting up the TrustZone boundary.

Transitioning from CM State to OEM State and setting up the TrustZone boundary can only be achieved
using the MCU'’s boot mode, which can be accessed using an SCI/USB or JTAG/SWD connection. To
access the boot mode via SCI boot pin over the JTAG connector, connect the P201/MD and SCI TXD, RXD
pin to the JTAG connector. Special debugger firmware has been developed to manage bringing the device
up in SCI boot mode to set up the TrustZone boundary (automatically drives MD pin) and then switch back to
debug mode as needed.

Hardware design must reference the EK-RA8M1 debug interface design (signals in red) to provide proper
connections to support the above functionality.

Pin No. | SWD JTAG Serial Programming using SCI
1 vcce vCC vcc

2 P210/SWDIO P210/TMS NC

4 P211/SWCLK P211/TCK P201/MD

Wired OR with MD | Wired OR with MD

6 P209/SWO P209/TDO/TXD9 | P209/TXD9
8 P208 P208/TDI/RXD9 P208/RXD9
9 GNDdetect GNDdetect GNDdetect
10 nRESET nRESET nRESET

Figure 12. Debug Connection to Support TrustZone® Design

The operational flow when using this feature differs between e? studio and the EWARM IDE.
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2.2.1 Developing with e? studio

When developing with e? studio and using Renesas evaluation kits for TrustZone MCUs, the MCU is
automatically transitioned from the CM state to the OEM state when the first secure program is downloaded
to the MCU if the above required connection is provided.

2.2.2 Developing with IAR EWARM

When developing with IAR EWARM, transitioning from CM to OEM needs to be performed manually using
RDPM or RFP. This is achieved by using the Initialize device back to factory default option as shown in
Figure 13.

2.2.3 Developing with Keil MDK

When developing with Keil MDK, transitioning from CM to OEM needs to be performed manually using
RDPM or RFP. This is achieved by using the Initialize device back to factory default option as shown in
Figure 13.

2.3 Setting up the TrustZone Boundary

Whether you are using e? studio or a third-party IDE like Keil MDK or IAR EWARM, you can manually set up
the TrustZone boundary using RDPM. As shown in Figure 13, the functionalities of the RDPM are under the
Action area. To set up the TrustZone boundary, select Set TrustZone secure / non-secure boundaries
and provide the TrustZone region sizes.

&} Renesas Device Partition Manager O *

€3 At least one action must be selected

Device Family: Renesas RA

Action

Functionality of /‘f Read current device information []Change debug state
RDPM

[] Set TrustZone secure / non-secure boundaries [ Initialize device back to factory default
=S

Target MCU connection: J-Link ~
Connection Type: SCl ~
Emulator Connection: Serial Mo ~
Serial No/IP Address: I:I
Debugger supply voltage (V): 0

Connection Speed (bps for 5CI, Hz for SWD): 2600

Debug state to change to: Non-secure Software Development

Memeory partition sizes

Used when working .\ N
with IAR EWARM | _——P I|:| Use Renesas Partition Data file I

Browse...

Code Flash Secure (KB)

IDAU region I Code Flash N5C (KB) 27
configuration Data Flash Secure (KB)

SRAM Secure (KB)

SRAM NSC (KE) 6

Command line tool:

Browse...

':?3' Import Export Run Close

Figure 13. Functionality of RDPM
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The RDPM also provides the following functionalities:

e Use Read current device information to read out the DLM and TrustZone boundary setup information.

e Use Change device lifecycle management state to transition to a different state.

e Use Initialize device back to factory default to transition the DLM state to OEM_PL2 if the device is in
OEM_PL1 or OEM_PLO state.

When using e? studio, the TrustZone boundary configuration is automatically loaded in the dialog box and
there are no additional actions needed to fill in the configuration data.

Pay special attention to the check box for Use Renesas Partition Data file. This check box is used when
setting up the IDAU region using IAR EWARM. You must use the generated . rpd fie to configure the
TrustZone boundary. This usage is described in section 5.5. Once an . rpd file is selected, the new IADU
region configuration information will be updated automatically based on the . rpd file.

Note: The . rpd filename is stored for future runs. When switching to another project, you must reselect
the . rpd file.

The operational flow for using the RDPM differs between e? studio, EWARM IDE and Keil MDK, as detailed
in the following sections.

2.3.1 Developing with e? studio

When using e? studio, the necessary values to set up the TrustZone® memory partition are calculated after
the binary code to program into the Secure region is created by building the Secure project. The regions are
set up to ensure that they match the code and data sizes and keep the attack surface as small as possible. If
the hardware connection mentioned in Figure 12 is provided in the PCB design, there is no need to use the
RDPM manually to set up the TrustZone bounary. Setting up the TrustZone boundary when developing with
e? studio is a transparent process for most applications.

2.3.2 Developing with IAR EWARM

Unlike e? studio, setting up the TrustZone boundary when developing with IAR EWARM needs to be
performed semi-manually using the RDPM. As part of the debug configuration generated when the RASC
creates a project for EWARM, there is the invocation of a C-SPY macro file called

partition device.mac as shown in Figure 14.
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Options for node "sensor_ns” >

Category: Factory Settings

General Options A
Static Analysis
Runtime Checking
C/C++ Compiler Setup Download Images Multicore Authentication Extra Options Plugins
Assembler
Output Converter Driver [ Run to
Custom Buid JHLink/J-Trace v main
Linker
Build Actions Setup macros
Debugger [~] Use macro file(s)
Simulator
CADI
CMSIS DAP
E2/E2 Lite
GDB Server
G+LINK
I-jet
J-Link/J-Trace $TOOLKIT_DIRS$\config\debuggeriRenesas\R7FASM1AH. ddf
TI Stellaris
Nu-Link
PE micro
ST-LINK
Third-Party Driver
TI MSP-FET v

$PROJ_DIRS$\partition_device.mac

Device description file

[] Ovemde default

Cancel

Figure 14. Debug Configuration for TrustZone Boundary Setup

As part of the debug startup sequence, this file will invoke the RDPM integrated to check the target MCU’s
TrustZone partition boundaries and compare them against the settings calculated as part of the project build
sequence. If a mismatch is found, a dialog is displayed asking you whether to reconfigure the TrustZone
boundary. You can then choose to launch the RDPM and set up the TrustZone boundary.

Lo =

‘:ef' Target device needs TrustZone partition sizes to be changed before debug session can be started.
Launch the Renesas Device Partition Manager tool?

Yes No

Figure 15. Prompt to Launch the RDPM

2.3.3 Developing with Keil MDK

Unlike e? studio, setting up the TrustZone boundary when developing with Keil MDK needs to be performed
manually using the RDPM. The walk through of setting up the TrustZone boundary when working with Keil
MDK is demonstrated in section 5.6.1.

3. General Considerations in TrustZone® Application Design

3.1 Non-secure Callable Modules

Some driver and middleware stacks in the Secure project may need to be accessed by the Non-secure
partition. To enable generation of NSC veneers, set Non-secure Callable from the right-click context menu
for the selected modules in the Configurator.

Note: Itis only possible to configure top of stacks as NSC.
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& g_uartD UART Driver on r_sci_uart
@ Teamn ¥
I A | Rescurce Configurations >
7 Add DTC Driver for 7 Add OTC Driver for |  Validate
Transmission Reception [Mot o Cut Ctrl+ X
[Recommended but recommended] E Y r
optional] [[E Copy Ctrl+C
Paste Ctrl+V
.  Delete Delete ':I? g_uartd UART Driver
Mon-secure Callable * ?1}? on r_scl_uart
Import... @
e/ Export.., -

Figure 16. Generate NSC Veneers

3.2 Guard Function for Non-secure Callables

Access to NSC drivers from a Non-secure project is possible through the Guard APIs. The FSP automatically
generates guard functions for all the top of stack/driver APIs configured in the Secure project as Non-secure
Callable.

Some best practices and guidelines for using the guard functions are listed as follows:

3.2.1 Limit Access to Selected Configurations and Controls

The default guard functions generated ignore p_ctrl and p_cfg arguments sent in from NS side. Instead,
the guard function provides static Secure region instances of these data structures based on the module
Instance.

BSP CMSE NONSECURE ENTRY fsp err t g uart0_open guard (
uart ctrl t *const p api ctrl, uart cfg t const *const p cfg) {
/* TODO: add your own security checks here */

FSP_PARAMETER NOT USED (p_api ctrl);
FSP_PARAMETER NOT USED(p_cfg) ;

return R _SCI UART Open (&g uartO ctrl, &g uartO cfq);

Figure 17. Example Guard Function

3.2.2 Test for Non-secure Buffer Locations

¢ |f the Non-secure region is providing input (such as by calling the write () function with data buffer),
then the guard functions should check that data buffer is entirely within an NS area.

o If the Non-secure region is providing a pointer to store output (such as by calling the read () function
with a pointer of where to store), then the guard functions should check that the data buffer is entirely
within a NS area.

See section 3.5.1 for examples of using the CMSE library to handle this requirement.

3.2.3 Handle Non-secure Data Input Structure as Volatile

If a Non-secure region is providing a data structure as input (for example, a typedef 'd structure with 3
members), then guard functions should make a copy of the data structure in the Secure region before
passing to the Secure function. This is done because Non-secure data structure should be seen as volatile,
and the Non-secure region could alter contents after invoking the NSC function.

See section 3.5.2 for an example of how to handle this requirement.
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3.2.4 Limit the Number of Arguments in an NSC Function

The compiler uses registers RO to R3 to pass parameters and return values. Registers R4 to R12 are used
during function execution. The called function restores registers R4 to R12. Therefore, if an NSC API is being
used for a Secure function with more than 4 arguments, the guard function should define a function with a
different prototype that will be a funnel to handle all of the arguments. The new function prototype should
take a data structure that has members to cover all parameters in the Secure function. This means that Non-
secure code will need to put the function arguments into the structure. The guard function will then expand
the data structure into separate arguments and pass them to the Secure function.

Figure 18 shows an FSP example for funneling the 5 arguments from the R_SPI WriteRead function to 4
arguments in the NSC API guard function.

/** Non-secure arguments for write-read guard function */
= typedef struct st_spi_write_read_guard_args

wvoid const * p_src;
wvoid * p_dest;
uint32_t const length;

spi bit width t const bit width;
f@spi write read guard args tH

/* This function has been modified to reduce the number of arguments. */

4 BSP_CMSE_NONSECURE_ENTRY fsp_err_t g spi® write read guard fanin(spi ctrl_t *const p_api ctrl,
spi write read guard args t *args)

1

/* Verify all pointers are in non-secure memory. */

spi_write_read_guard_args_t *args_checked = cmse_check pointed object (args, CMSE_AU_NONSECURE);

FSP_ASSERT (args == args_checked);

vold const *p_src_checked = cmse_check_address_range ((void*) args_checked-»p_src, args_checked->length,
CMSE_AU_NONSECURE);

FSP_ASSERT (args_checked-»p_src == p_src_checked);

vold *p_dest_checked = cmse_check_address_range (args_checked-»p_dest, args_checked->length, CMSE_AU_NONSECURE);

FSP_ASSERT (args_checked-»p_dest == p_dest_checked);

: add your own security checks here */

FSP_PARAMETER_NOT_USED (p_api_ctrl);

I return R_SPI_WriteRead (&g_spi®_ctrl, p_src_checked, p_dest_checked, args_checked-:length, args_checked->bit_width}; I

}

Figure 18. Handling Secure Functions with More than 4 Arguments

3.3 Creating User-Defined Non-secure Callable Functions

For IP protection purposes, you can create a customized NSC API in the Secure project to expose only the
top-level control of your algorithms and store the IP in the Secure Arm® TrustZone® region. Precautions
mentioned previously should be exercised during the creation of the user-defined NSC API.

Steps to create a customized NSC API are:

1. Create the Non-secure Callable custom function by declaring the function with
BSP CMSE NONSECURE ENTRY.

2. Create a header file that includes all the customized NSC function prototypes, for example,
my nsc_api.h.

3. Include the path to the NSC header using the Build Variable as shown in Figure 19.

4. Compile the Secure project to create the Secure bundle. The NSC header will be automatically extracted
in the Non-secure project for use.
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Q Properties for bare_metal_minimum_s O X
[ type filter text Build Variables v v 8
Resource
Builders
~ CfC++ Build Configuration: |Release [ Active ] ~| | Manage Configurations...

Build Variables
Environment

Legging

Settings Name Type Value Add...
Tool Chain Editor UserNscApiFiles File List "S{workspace_loc/bare_metal_minimum_s/src/my_nsc_apih}" Edit
C/C++ General

MCU Delete
Project Matures
Project References
Renesas OF
Run/Debug Settings

Task Tags
Validation
[ show system variables
Build Variables are IDE only variables, which can be used for string substitution when defining external builder configuration, such as environment
variable value or command line parameter in form of §{VAR}, internal builder may use them directly.
Restore Defaults Apply
':?:' Apply and Close Cancel

Figure 19. Link User-Defined Non-secure Callable API Header File

3.4 RTOS Support

Renesas tooling and the FSP support Non-secure partition RTOS integration with Secure region access
through Non-secure callable APIs. Secure projects can use the Secure TrustZone Support — Minimum
project type to add the Arm TrustZone Context RA port. For operation details, see section 4.1.1, Step 3 for
Secure Project handling and section 4.1.2, Step 5 Non-secure Project Handling.

3.5 Writing TrustZone Technology Enabled Software

Security design using TrustZone technology has some specific challenges that secure developers should
bear in mind and take corresponding actions when writing the secure application software.

This section provides several guidelines that secure software developers should consider following in order
to avoid Secure information leakage to the Non-secure region.

3.5.1 Benefitting from CMSE Functions to Enhance System Level Security

This subsection discusses how to benefit from the CMSE library to improve the secure software design.
Some examples of the CMSE functions are:

e cmse check address_ range: For example, this function can be used to confirm the address range is
entirely in the Non-secure region.

e cmse check pointed object: For example, this function can be used to confirm the memory
pointed to by the pointer is entirely in the Non-secure region.
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BSP_CMSE NONSECURE ENTRY fsp err t g_uart0_read guard(uart ctrl t *const p api ctrl,
uint8 t *const p dest,
uint32 t const bytes)

{

/* Verify all pointers are in non-secure memory. */

uint8_t *const p_dest checked = cmse_check_address_range ((void*) p_dest, bytes,
CMSE_AU NONSECURE) ;

FSP_ASSERT (p_dest == p dest checked);

/* TODO: add your own security checks here */
FSP_PARAMETER NOT USED (p_api ctrl);

return R SCI UART Read (&g uartO ctrl, p dest checked, bytes);

Figure 20. Non-secure Buffer Address Range Check

3.5.2 Avoid Asynchronous Modifications to Currently Processed Data

An example of handling is shown in Figure 21. When the pointer p points to Non-secure memory, it is
possible for its value to change after the memory accesses used to perform the array bounds check, but
before the memory access is used to index the array. Such an asynchronous change to Non-secure memory
would render this array bounds check useless.

int array|[N];
void foo(volatile int *p)
{
int i = *p;
if (1 > 0 && 1 < N) { arrayl[i] = 0; }

Figure 21. Treat Non-secure Data as Volatile in Secure Code

3.5.3 Utilize the Armv8-M Stack Pointer Stack Limit Feature
The Armv8-M architecture introduces stack limit registers that trigger an exception on a stack overflow.

CM23 with Arm® TrustZone® technology has two stack limit registers in the Secure state:
e Stack Limit Register for Main Stack: MSPLIM_S
e Stack Limit Register for Process Stack: PSPLIM_S

CM33 and CM85 with TrustZone technology has two stack limit registers in the Secure state and two stack
limit registers in the Non-secure state:

e Stack Limit Register for Main Stack in Secure state: MSPLIM_S

e Stack Limit Register for Process Stack in Secure state: PSPLIM_S

e Stack Limit Register for Main Stack in Non-secure state: MSPLIM_NS

e Stack Limit Register for Process Stack in Non-secure state: PSPLIM_NS

Users can implement customized fault handlers to catch the stack limit overflow error.

Refer to Arm®v8-M Architecture Reference Manual section The Armv8-M Architecture Profile for more
information on the functionality of the stack limit registers.

4. Using Renesas RA Project Generator for TrustZone Development

The RASC is designed for TrustZone technology based applications. It provides ease of use based on the
following implementation features from the tools and FSP point of view:

e RA Project Generator guides you through the TrustZone project creation process.

e TrustZone boundary setup during Secure program download, calculated automatically based on the
Secure project. See section 2.1 for more details.

e The FSP provides a quick and versatile way to build secure connected IoT devices using Renesas RA
MCUs.

Note: FSP version information is removed from the following screen captures because these instructions
apply to all FSP versions 5.4.0 or later.
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RA Project Generator

The RA Project Generator provides three project types to create the initial template projects for developing
with Arm® TrustZone® technology enabled MCUs:

e A Secure Project and Non-secure Project Type pair which work with the Secure and Non-secure
partitions respectively.

e A Flat Project with which an application can be developed with no TrustZone partition awareness.

e Whether developing with a TrustZone enabled project or with a Flat project, the MCU needs to transit
from the CM state to the OEM state prior to proceeding with the development.

&} Renesas RA C/C++ Project O ped

Renesas RA C/C++ Project —_—
Project Type Selection

Project Type Selection

(® Flat (Non-TrustZone) Project
* Renesas RA device project without TrustZone separation
® All code, data and peripheral settings will be configured in
this project
* Renesas RA device will remain in secure mode
* EDMAC RAM buffers will automatically be placed in non-
secure BALY

() TrustZone Secure Project

* Renesas RA device project for TrustZone secure execution

® All code, data and peripherals placed in this project will be
initialized as secure

® Secure project settings such as TrustZone partitions, linker
rmaps and a list of secure peripherals will be passed to a
selected non-secure project

® Afterinitialization, a call to the non-secure startup handler
will be made

() TrustZone Non-secure Project

* Renesas RA device project for TrustZone non-secure
execution

® All code, data and peripherals placed in this project will be
initialized as nen-secure

® Must be associated with a secure project or secure bundle

* Non-secure startup handler will be called after secure code
initialization

@ < Back Next > Finish Cancel

Figure 22. RA Project Generator
For RA TrustZone technology enabled MCUs, there are two development models:

e Combined Project Development
— Secure and Non-secure applications are developed by one trusted team.
e Split Project Development
— Secure and Non-secure applications are developed by two different teams.
— The Non-secure application team does not have direct access to Secure partition assets. Access to
Secure partition is only possible via Non-secure Callable APIs.

The design process based on each of these two development models are introduced in the subsequent
subsections. The design process based on the Flat Project type is introduced in section 4.3.
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4.1 Combined Project Development

With the Combined Project Development Model, Secure and Non-secure projects are developed by a single
trusted team. A Secure project must reside in the same workspace as the Non-secure project and is typically
used when a design engineer has access to both the Secure and Non-secure project sources.

In addition, a Secure .e1f file is referenced and included in the debug configuration for Debug build for
download to the target device. The development engineer has visibility of Secure and Non-secure project
source code and configuration.

4.1.1 Developing the Secure Project

Most peripherals and 10 defined in the Secure project are configured as Secure with the exceptions of Clock,
QSPI, OSPI, and the CS Area. These peripherals can be used in the Secure project and be configured as
Non-secure.

The major IDE operational steps in developing the Secure project are explained in the following steps.
Step 1: Create a new project using the RA Project Generator template.
Renesas RA MCU tooling provides several project templates to help kickstart development.

Figure 23 to Figure 27 show some common steps when creating a new project with e? studio regardless of
whether Secure or Non-secure projects are to be created with either the Split Project Development Model or
Combined Project Development Model.

e This step will be referenced in the context of Non-secure Project Development for the Combined Project
Development Model.

e This step will be referenced in context of Secure and Non-secure Project Development for the Split
Project Development Model.

& ws_1 - e? studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help

New Alt+Shift+N > I Renesas C/C++ Project >
— -
Open File... |ci| Makefile Project with Existing Code
. Open Projects from File System... I:LI C/C++ Project
Recent Files > ™ Project..
Close Editor Ctrl+W & Convert to a C/C++ Project (Adds C/C++ Nature)
Close All Editors Ctrl+Shift+W | =«

1 Source Folder

Save Ctrl+5S 1 Folder

Figure 23. Create New Project

Q New C/C++ Project O X

Templates for New C/C+ + Project

CMake Create a CMake project with no files. Can be used to
Make create one over existing content.
Renesas Debug . .
Renesas RA #~ Makefile Project
w=." (Experimental) Create a new project that builds with
the'make' build tool using CDT's new Core Build System

! Empty or Existing CMake Project e

Renesas Debug Only Project
aenesas Renesas Debug Only Project

Renesas RA C/C++ Project
== Create an executable or static library C/C++ project
for Renesas RA.

< Back Next = Finish Cancel

Figure 24. Select “Renesas RA C/C++ Project”
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Click Finish, then provide the Secure project name. It is helpful to attach “ s” (for Secure”) and “ ns” (for
Non-secure) to the end of the project name as a reminder of the security nature of this project.

ﬁ Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Name and Location

Project name

I bare_metal_minimum_5| I

Use default location
CAIOTSG-28

default

You can download more Renesas packs here

L == 0 = =

3538\ new_ws\bare_metal_

minimum_s Browse...

< Back Mext = Finish Cancel

L= o =T S B B B L R =LA

Figure 25. Define the Name of the Secure Project

Click Next, then select the EK-RA8M1 BSP.

Evaluation kit for RASM1 MCU Group
Board: EK-RABM1 v
_ EK-RAGE2 = Visit TBD to get kit usej-r's manual, quick start guide, errata, design
Device: EK-RA6M1 package, example projects, etc.
Care: EK-RAGM2 i .
EK-RA6M3 Device Details
Language:  EK-RA6M3G TrustZone Yes
EK-RAGM4 Pins 224
EK-RA6MS Processor Cortex-M85
K-RABD
EK-RA8M1

Figure 26. Select the BSP

Note: By default, the BSP functionality with regard to security control is only enabled in the Secure project.
Once the BSP is selected, click Next to view the summary for the hardware setup page.

Evaluation kit for RA8M1 MCU Group
Board: l EK-RABM1 I i
Visit TBD to get kit user's manual, quick start guide, errata, design
Device: R7FABM1AHECBD package, example projects, etc.
Core: CMB85
Device Details
language: @IC OC++ TrustZone Yes
Pins 224
Processor Cortex-MB5
Toolchains Debugger
GNU ARM Embedded J-Link ARM =
LLVM Embedded Toolchain for Arm
IAR Toolchain for Arm - (9.x)
13.2.1.arm-13-7 e
@ < Back Finish Cancel

Figure 27. Review the Co

Click Next and proceed to the following steps.

nfigurations Prior to Proceeding to Next Step
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Note: Step 2 to Step 7 below are common for the Split Project Development Model and Combined Project
Development Model. These steps are referred to in context of the Secure Project development for the
Split Project Development Model.

Step 2: Choose the TrustZone Secure Project as the Project Type.

Choose TrutZone Secure Project as the project type and take a moment to read the description on this
project type. All peripherals initialized in this project will be assumed to have the Secure
attribute with the exceptions indicated in

Table 4 as Always Non-secure. All code and data placed in this project will be initialized as Secure by the
FSP BSP and control will be passed to Non-secure project reset handler at the end of the Secure project
execution.

{2} Renesas RA C/C++ Project O *

Renesas RA C/C++ Project —
Project Type Selection

Project Type Selection

(O Flat (Non-TrustZone) Project
* Renesas RA device project without TrustZone separation
* All code, data and peripheral settings will be configured in
this project
Renesas RA device will remain in secure mode
* EDMAC RAM buffers will automatically be placed in non-
secure RAM

l (®) TrustZone Secure Project I
Enesas evICe project tor TrustZone secure execution )

* All code, data and peripherals placed in this project will be
initialized as secure

® Secure project settings such as TrustZone partitions, linker
maps and a list of secure peripherals will be passed to a
selected non-secure project

= After initialization, a call to the non-secure startup handler
will be made

-

(O TrustZone Non-secure Project
* Renesas RA device project for TrustZone non-secure execution
* All code, data and peripherals placed in this project will be
initialized as non-secure
* Must be associated with a secure project or secure bundle
# Mon-secure startup handler will be called after secure code
initialization

'f?:' < Back Mext » Finish Cancel

Figure 28. Choose the Secure Project Type
Click Next and choose the Project Template.
Step 3: Choose the project template.

As shown in Figure 29, there are two Secure project templates. You can choose which template to use
based on whether an RTOS is used in the Non-secure project.

e Bare Metal — Minimal
Secure project with MCU Initialization function with support on transitioning to Non-secure partition. This
application note uses the Bare Metal — Minimal project template as example to explain the general
steps creating a secure project.
e TrustZone Secure RTOS — Minimal
— Secure projects will add the required RTOS context in the Secure region for the Thread that needs to
access the NSC APIs in an RTOS enabled project. When this project type is selected, the Arm
TrustZone Context RA Port will be added as shown in Figure 30.
— The RTOS kernel and user tasks will reside in the Non-secure partition.
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Q Renesas RA C/C++ Project | X
Renesas RA C/C++ Project —
Project Template Selection
Project Template Selection
® . . e G
g Bare Metal - Minimal
W% . Bare metal F5P project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.
. - - . -
O () TrustZone Secure - Minimal project with support for Non-secure RTOS
, Empty TrustZone Secure project with Non-secure callable RTOS context functions that will allow threads in a
Non-secure application to call Secure services. This is not support for using an RTOS in a Secure project. Without these
RTOS context functions, there could be issues if a context switch occurs while a thread in the Non-secure application is
executing a Secure service. This will support any RTOS as long as the RTOS uses the CMSIS TrustZone Context
Management API. This project will initialize the MCU using the BSP. v
Code Generation Settings
Use Renesas Code Formatter
@ < Back Next > I Cancel
Figure 29. Choose the Project Template
| @ Renesas RA C/C++ Project [m] *
Renesas RA C/C- + Project —
Project Template Selection
Project Template Selection
O " Bare Metal - Minimal =
() Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.
I!-' 6 " TrustZone Secure - Minimal project with support for Non-secure RTOS I
Non-secure application to call Secure services. This is not support for using an RTOS in a Secure project. Wlt‘huut these
RTOS context functions, there could be issues if a context switch occurs while 2 thread in the Non-secure application is
executing a Secure service. This will support any RTOS as long as the RTOS uses the CMSIS TrustZone Context HAL/Common Stacks
Management API. This project will initialize the MCU using the BSP, v
Code Genera ; I
[ZUse Renesas Code Formatter 4 g_icport |/0 Port 48 ARM TrustZone
' Driver on r_ioport Context RA Port
z N once l

Figure 30. Adding the TrustZone Context RA Port
Click Finish to allow the Project Generator to populate the project template.

Notes on Clock Control

The clock is initialized in the Secure project to allow faster start up. By default, the FSP sets all the security
attributes of the Clock Generation Circuit (CGC) to be Non-secure as shown in Figure 31. Therefore, both
Secure and Non-secure projects can change the clock setting.

Users have the option to set all the security attributes of CGC as Secure, thus the Non-secure project
developer cannot override the secure project setting as shown in Figure 32.
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(&) Secyity =2 Resiore Refaults
»[E—— » CPUCLKDIV/1 e o S_E.tsfﬁit.lis_r the clock circuit is secure or non-secure (currently secure; override disabled)
ICLK Div /2 ¥ — |CLK 240MHz

Details on the Lock Icon

{1 Securi (&) Securi
Mot Locked . ty Locked - ty

Figure 31. Secure Project sets Clock as Secure

O
Generate Project Content
I 1\ Security [T Restore Defaults
> Clock Src: PLL1P &2 —<—>CPUCLKD|V /1 ¥ —>CPUCLK 480MHz 2
I ICLK Div /2 ¥ —> |CLK 240MHz
N> PCLKA Div /4 ~ — PCLKA 120MHz
> PCLKB Div /8 ¥ —> PCLKB 60MHz
> PCLKC Div /8 ¥ —> PCLKC 60MHz
> PCLKD Div /4 ¥ —> PCLKD 120MHz

Figure 32. Non-secure Project Clock control “Override and Restore Default” Disabled
Step 4: Generate Project Content and compile the project template.

Double click configuration.xml to open the configurator. Click Generate Project Content as shown in
Figure 33Figure 33.

{ij [bare_metal_minimal_s] FSP Configuration £2

Stacks Configuration
9 Generate Project Content

HAL/Common Stacks 4| Mew Stack »
Threads

=
v & HAL/Common
£

49 g_ioport /0 Port
Driver on r_ioport

®

<>

Objects

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

Figure 33. Generate Project Content

Right-click on the project and select Build Project.
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I_s/configuration.xml - & studio

Project RenesasViews Run Window Help

g ~ || [E7] bare_metal_minimal_s Debug ~ 9~ BrR G

3

= [ {& [bare_metal_minimal_s] FSP Configuration &

7 8

g

B
el New >

— P

Go Into
HAL/Common Stacks
Open in New Window

Show In Alt+Shift+W > 4% g_ioport /O Port
i; Copy CtrlsC Driver on r_ioport
Paste Ctrl+V )
D 3¢ Delete Delete
Source >
9 Move...
Rename... F2 Event Links | Stacks | Components
iv  Import...
Za Export..

i3 Export FSP Project...
(R)  Export FSP User Pack...

Build Project |_In<rementa\ Build of Selected Projects I

Clean Proiect

Figure 34. Compile the Template Project

Note: By default, the GPIO driver to control the Secure GPIO pins is included in the template. You can

remove the GPIO driver, if is not needed, to reduce the project footprint.

Figure 35 is an example of the compilation result based on Bare-Metal Minimum project template.

CDT Build Console [bare_metal_minimum_s]
........ e

Building file: . .fraf’board/rasm:ek/boardZIEds.c
Building target: bare_metal_minimum_s.elf

arm-none-eabi-size --format=berkeley "bare_metal_minimum_s.elf”
text data bss dec hex filename

arm-none-eabi-objcopy -0 srec "bare_metal_minimum_s.elf" “bare_metal_minimum_s.srec”

Figure 35. Compilation Result of the Bare-Metal Minimum Secure Template Project

Step 5: Review the initial Secure bundle generated.

After successful compilation, the Secure bundle <project name>.sbd is generated as shown in Figure

36.

&5 Project Explorer 23 = <§> r &8 = 0§
w % bare_metal_minimal_s [Debug]
qg-? Binaries
[a Includes
= ra
2 ra_gen
= src
w = Debug
= ra
= ra_gen
= src
:)t& bare_metal_minimal_s.elf - [arm/le]
secure.o - [arm/le]
|=| bare_metal_minimal_s.elf.in

| : bare_roetal minimal s.map

bare_metal_minimal_s.sbd

bare_metal_minimal_s.srec
makefile

makefile.init

| & objects.mk

i E@ [} [

| @ sources.mk

o ra e

Figure 36. Secure Bundle Generated

Step 6: Develop the Secure application.

During the product development, it is likely that you will go through the following steps iteratively prior to

completing development:
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e Add Needed FSP Modules:
— Define NSC Modules if needed. See Section 3.1 for details.
— Note: Ethernet cannot be used in the Secure Project. It is only available in the Non-secure Project.
e Create user-defined Non-secure Callable Functions if needed. See section 3.3 for details.
e Develop the Secure applications:
— Design the code flow such that the Secure applications that are not Non-secure Callable are
executed prior to starting the Non-secure project execution: prior to function call
R BSP NonSecureEnter () ;
e Recompile and test the application.

Step 7: Debug the Secure project in isolation.

With the Combined Project Development Model, the Secure project is typically not debugged in isolation
from the Non-secure project. To debug a Secure project on its own, you can use the following options:

e Prepare a “dummyi/test” Non-secure project. This approach offers the benefits of allowing the Non-secure
Callable APIs to be debugged in the test Non-secure project.

e Replace R BSP NonSecureEnter (); withwhile(1); inhal entry.c and debug the Secure
project by itself. Be sure to restore the R BSP NonSecureEnter () ; after debugging the Secure project
prior to provisioning the Secure project to the MCU.

Step 8: Debug the Secure project with the Non-secure project.

For the Combined Project Development Model, Secure and Non-secure project development can be
debugged in one workspace. Debugging the Secure project typically does not happen in an isolated manner
for the Combined Project Development Model. See Section 4.1.2, Step 7 for operational details.

4.1.2 Developing the Non-secure Project

Once the Secure template project is established and compiled, you can start the Non-secure template
project creation in the same workspace where the Secure project resides.

Step 1: Follow Step 1in section 4.1.1 to start a new Non-secure project.

It is helpful to attach “ ns” to the end of the project name as a reminder of the security configuration of this
project.

Step 2: Choose Non-secure project as the Project Type.

Renesas RA C/C++ Project —

Praject Type Selection

Project Type Sel

) Flat (Non-TrustZone) Praject
 Renesas RA device project without TrustZone separation

this project

o

* Renesas RA device will remain in secure made

* EDMAC RAM buffers will automatically be placed in non-
ure

Figure 37. Choose Non-secure Project as Project Type
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Step 3: Establish linkage to the Secure project which resides in the same e? studio workspace.

Click the down arrow and select the secure project bare_metal_minimum_s created in section 4.1.1.

Note: The Secure project must exist in the same workspace AND be open for it to be referenced in the
selection box. The Secure project must also be built to create the information used to set up the Non-

secure project.

g Renesas RA C/C++ Praject

Renesas RA C/C++ Project

Preceding Project or Smart Bundle Selection

@ Preceding Project: |bare_metal_minimal_s

(O Smart Bundle:

i00se this option IT you have access 10 the preceding lrustZone Secure Project source code.
Secure Software Debug (SSD) state will be generated and both secure and non-secure images will be downloaded to

the target device. Should you wish to test Non-Secure Software Debug (NSECSD) state, use the Renesas Device Partition
Manager to change the Device Lifecycle state as needed.

ebug configuration for

Workspace... File System... Variables...

Preceding Project/Smart Bundle Details

FSP version 540

Toolchain GNU ARM Embedded

Toolchain version 13.2.1.arm-13-7

Board EK-RABM1

Device R7TFASM1AHECBD

Core CM85

Zones CM85_S
@ < Back nish Cancel

Figure 38. Establish Linkage to the Secure Project

Click Next to proceed.

Step 4: Follow the prompt as shown below to choose whether the Non-secure project will have RTOS

support.

8 Renesas RA C/C++ Project

Renesas RA C/C++ Project
Build Artifact and RTOS Selection

Build Artifact Selection

(@ Executable
® Project builds to an executable file

RTOS Selection

e

< Back Cancel

-

Norls —— —
Azure RTOS ThreadX (version)
FreeRTOS version

Figure 39. Choose Whether to Use FreeRTOS in the Non-secure Project

Click Next to proceed.
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Step 5: Select the project template to finish creating the Non-secure template project.

o |If FreeRTOS is selected, the Project Generator provides the following two project templates. Choose the
project template based on the application needs. An example for FreeRTOS is shown as follows. Azure
RTOS has similar options.

{8} Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —

Project Template Selection

Project Template Selection

@ (—} FreeRTOS - Blinky - Static Allocation
- FreeRTOS FSP project that includes BSP and will blink LEDs if available. FreeRTOS is pre-configured for static memory
allocation. This project will initialize the MCU using the BSP. FreeRTOS will also be initialized and a single thread to blink the
LEDs will be started.

I ® g " FreeRTOS - Minimal - Static Allocation I
£

Empty FreeRTOS FSP project with no threads. FreeRTOS is pre-configured for static memory allocation. This project will
initialize the MCU using the BSP.

Code Generation Settings
Use Renesas Code Formatter

'i?;' < Back Mext » | Cancel

Figure 40. Template Options for FreeRTOS Enabled Projects

Note: If FreeRTOS is selected and there is access to NSC functions from a Thread in the Non-secure
project, it is necessary to enable Allocate secure context for this thread in the configurator for that

Thread.

~ Thread
Symbol new_thread0
Name New Thread
Stack size (bytes) 1024
Priority 1
Thread Context NULL

il (tuir
I Allocate Secure Context Enable I

Figure 41. Enable Secure Context Allocation

o If No RTOS is selected, the Project Generator provides the following two project templates.
Note: The No RTOS selection must be selected if a new RTOS other than FreeRTOS is to be integrated in
the Non-secure project.
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{8} Renesas RA C/C++ Project O X
Renesas RA C/C++ Project —
Project Template Selection |
Project Template Selection
O (}' Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and
the C runtime environment.

® ' Bare Metal - Minimal
%rmm BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

[ @ < Back Next » ‘ Cancel

Figure 42. Template Options for Non-FreeRTOS usage

e Click Finish to create the corresponding template project.

Note: Even though there are security properties allowed for configuration in the BSP Properties page, they

are not being enabled with the current IDE support. The following attributes cannot be configured from
the Non-secure project:

[T Properties x |I£1 Problems| @ Smart Browser B Console
EK-RABM1

Settings Property Value
R7FABM1AHECBD
RABM1

v RABM1 Family
~ Security

Exceptions
SRAM Accessibility
BUS Accessibility
System Reset Request Accessibility Secure State
System Reset Status Accessibility Both Secure and Non-Secure State
Battery Backup Accessibility Both Secure and Non-Secure State
Flash Bank Select Accessibility Both Secure and Non-Secure State
Uninitialized Non-Secure Application Fallback Enable Uninitialized Non-Secure Application Fallback
¥ OFSO0 register settings
Independent WDT
WDT0
OFS1_SEL register settings
v OFS1 register settings

Voltage Detection 0 Circuit Start Voltage monitor 0 reset is disabled after reset

Voltage Detection 0 Level 160V

Voltage Detection 0 Low Power Consumption Voltage monitor 0 Low Power Consumption Disabled

HOCO Oscillation Enable HOCO oscillation is disabled after reset

WDT/IWDT Software Debug Control Disabled (WDT and IWDT continue operating while the CPU is in the debug state)
Tightly Coupled Memory (TCM)/Cache ECC Disable ECC function for TCM and Cache

OFS2 register settings
~ Block Protection Settings (BPS)
BPSO
BPS1
BPS2
BPS3
v Permanent Block Protection Settings (PBPS)
PBPSO
PBPS1
PBPS2
PBPS3
First Stage Bootloader (FSBL)
Clocks
Cache settings
Enable inline BSP IRQ functions Enabled
Dual Bank Mode Disabled

Figure 43. Attributes That Are Not Configurable from a Non-secure Project
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e By default, the Non-secure project BSP can reconfigure the MCU clock. Refer to Notes on Clock Control.

Step 6: Follow Instructions from Step 1, Section 4.1.1 to Generate Project Content and compile the
Non-secure project.

Notice that both the Secure project bare metal minimun s andbare metal minimum ns reside in
the same workspace.

5 Project Explorer < | =5 § = O ||{ (bare_metal_minimal_s] FSP Config... 4% [bare_metal_minimal_ns] FSP Confi.. X | = O | % FSP Visualization =8
_Vrc bare_metal_minimal_ns - Qo 1 A
> »
) Includes Stacks Ccmfiguratlon Generate Project Content n - -
Era
(®ra_gen Threads % | New Thread g_ioport I/0 Port % | New Stack >
B src ® |Remove = (r_ioport) Stacks
: : — v 5 ]
(= Debug ~ g HAL/Common P R =R Y 12191 1 T 9=
=>ra_cfg 'gg,iopurt 1/O Poi 9 |‘opur[ /0 Port o ) mee wee men su (i) () () () () () ) el o s o
o (r_ioport)
(& script 4 FreeRTOS Port o
X| bare_metal_minimal_ns Debug_SSD.lat £ New Thread ® - R
/2% configuration.xml o) ) () () () e () () ()
ra_cfg.txt 1 I I X2
(%) Developer Assistance <) = 6 @ ) e =) 6
15 bare_metal_minimal_s “Iz1z1z1 1 12 '::’ m o
I ir =l 1. 1L 1o
< > v () ) o () ) ) e
ObJ_MSOLNewobject: SILIITIITL R
FESCREE - @
SHOOMHOBSS -
= D TR

Figure 44. Compile the Non-secure Project (No RTOS, Bare-Metal Minimum)
Step 7: Debug both the Secure and Non-secure projects.

As shown in Figure 45, the debug configuration of the Non-secure project programs both the Secure and
Non-secure .elf files to the MCU by default to allow a unified debug session of both the Secure and Non-
secure projects.

Notice that <project name> <build configuration> SSD.launch is generated, as debugging both
Secure and Non-secure projects are performed in device lifecycle state OEM_PL2.

Q Debug Configurations O X
<

Create, manage, and run configurations @

LE] 5 = x‘ =1 Name: ‘ bare_metal_minimal_ns Debug_SSD ‘

‘ type filter text ‘ [ Main %‘5 Debugger | & Startup E Source -] Common
[€]c/C++ Application
[€]¢c/C++ Remote Application

EASE Script
[£] GDB Hardware Debugging [T Halt
[c*] GDB Simulator Debugging (RH850)
© IAR C-SPY Application
R Launch Group

Initialization Commands

[JReset and Delay (seconds): 3

v oY
[ ] bare_metal_minimal_ns Debug_SSD Load image and symbols
_ ] bare_mleta\_mlmma\_s Dlebug Filename Load type Offset (hex)  On connect Add
E Renesas Simulator Debugging (RX, RL78) bare_metal_minimal_s.el... Image and Symbols 0 Yes
Program Binary [bare_m... Image and Symbols 0 Yes Edit
Remove
v
Revert Apply

Filter matched 11 of 13 items

@ Close

Figure 45. Debug Both the Secure and Non-secure Projects

R11ANO897EU0100 Rev.1.00 Page 38 of 75
Nov.13.24 RENESAS




Renesas RA Family Security Design using Arm TrustZone - Cortex M85

Note: The Secure project must be built each time it is changed to ensure that the connection to the Non-
Secure project is maintained. When the Secure bundle changes, there will be a popup window asking
you to take the latest Secure bundle. Click Yes, then recompile the Non-secure project so that the
updated <project_name>.sbd will be used.

Q [bare_metal_minimal_ns] FSP Configuration e

% The secure bundle file 'bare_metal_minimal_s.sbd' has changed, do you want to
¥ restart this editor?

Figure 46. Secure Bundle Update Notification
Tips on Ensuring Synchronization between Secure and Non-secure Project

To avoid accidental updates from the Secure Project being missed, you can also define the Secure project
as a reference to the Non-secure project so that compiling the Non-secure project will automatically trigger a
compilation to the Secure project.

Open the Properties page of the Non-secure project, click Project References and choose the
corresponding Secure project as the Reference project. Once this is set up, compiling the Non-secure project
will always trigger the Secure project to be recompiled.

& Properties for bare_metal_minimal_ns O s
‘ type filter text | Project References =1 v 8
Resource ~ . . .
Builders Projects may refer to other projects in the workspace. ~
ui

Use this page to specify what other projects are referenced by the project.
v C/C++ Build

Build Variables

Environment

Logging

Settings

Tool Chain Editor
C/C++ General
Project Natures

Project references for 'bare_metal_minimal_ns":

C ..
=~ bare_metal_minimal_s

I Project References I

Renesas QE
Run/Debug Settings
Task Tags

@ Apply and Close Cancel

Figure 47. Create Project Reference

4.1.3 Production Flow Overview

This step is for production flow; it is not a step needed during development. Once both Secure and Non-
secure project development is finished, you can send the following information to the production line for the
MCU to be provisioned prior to selling:

e Secure binary
e Non-secure binary
e TrustZone Boundary configuration

Refer to section 6.2 to program the Secure binary and section 6.3 to program the Non-secure binary and
transition the MCU state to one of the following device lifecycle states:

e LCK_BOOT (LoCKed BOOT interface): The debug interface and the serial programming interface are
permanently disabled.
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4.2 Split Project Development
Characteristics of the Split Project Development Model include:

e The Secure project and Non-secure projects are developed separately by two different teams.

e The Secure project will be developed first by the IP provider. The IP provider creates a Secure bundle.

e The Secure bundle is pre-programmed on the device prior to the Non-secure developer starting their
development. Only the Non-secure project and Non-secure patrtition are visible to the Non-secure
developer.

4.2.1 Developing the Secure Bundle and Provisioning the MCU

Developing the Secure project using the Split Project Development Model is very similar to the Combined
Project Development Model. However, several key differences are explained in this section.

Step 1: Follow Step 1to Step 6 from Section 4.1.1 to establish the Secure template project and create
the applications.

Debugging the Secure project with the Split Project Development Model will not happen with the Non-secure
project for the product. As explained in Step 7, section 4.1.1, you can create a dummy Non-secure project for
the purpose of Secure project testing, for example to test the Non-secure callable APIs.

Step 2: Provision the MCU with the Secure project and change the device lifecycle state to OEM_PL1.

A major difference between Split Project Development and Combined Project Development is that the
Secure binary associated with the Secure bundle needs to be provisioned to the MCU prior to the Non-
secure project development for the Split Project Development. The Secure bundle contains the Secure
project IP in binary format and the NSC API interface from Secure project. In addition, the MCU device
lifecycle state needs to transition from OEM_PL2 to OEM_PL1 to protect the Secure content.

4.2.2 Limitations and Workarounds for Developing in OEM_PL1 State

There is a limitation with the current version of the tools in that a dummy Non-secure project must be
provisioned on the device in addition to the Secure binary prior to changing the MCU device lifecycle from
OEM_PL2 to OEM_PL1 with the Split Project Development Model. This is necessary to allow the Non-secure
development to resume in the OEM_PL1 state.

¢ Inthe development stage, follow the Combined Project Development Model to prepare a dummy Non-
secure project paired with the intended Secure project. Program the Secure binary and the dummy Non-
secure binary first and then change the device lifecycle state to OEM_PL1.

¢ Inthe production stage, send the following items to the production team:
— Secure binary
— TrustZone boundary information
RFP will be used to program the Secure binary and set up the TrustZone boundary. See section 6.2 for
the operational detalils.

¢ Note that the Secure developer also needs to provide the Secure bundle (<project_name>.sbd) to the
Non-secure developer to allow Non-secure project to proceed to development.

e See Figure 48 for details on the general flow to support Non-secure project development in the NSECSD
state.

4.2.3 Developing the Non-secure Project in OEM_PL1 State

Developing a Non-secure project using the Split Project Development Model has some key differences
compared with the Combined Project Development Model.

For the Split Project Development Model, the Non-secure application developer receives the MCU in the
OEM_PL1 state. As mentioned towards the end of last section, special handling is needed to enable
development in the OEM_PL1 state. Figure 48 is a summary of the general flow for developing in the
OEM_PL1 state.
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I

I

: Develop and test
i Secure application
X with TEST Non

. Secure project

I
I

___________ SECUME dEVEIOPET = = - o o e e e e e e e e e e e e e e e e

Program Secure and Change Lifecycle Pass provisioned device and
TEST* Non-Secure state (DLM) to Secure bundle file (*.sbd) to
code into device OEM_PL1 Non-Secure developer

Start new Non-Secure
project and select Secure 2>
bundle file (*_sbd)

Debug using OEM_PL1
debug configuration

Figure 48.

Development Flow for Developing in OEM_PL1 State

Once the Non-secure developers receive the MCU provisioned with the Secure binary, TrustZone boundary,
and the Non-secure dummy binary in the OEM_PL1 state, they can use the following steps to proceed to the
Non-secure project development:

1. Follow step 1 and step 2 in section 4.1.2 to start Non-secure project development.
Typically, the Non-secure project will be created in a different workspace from the Secure project as the
Secure project source file and . e1f file will not be available for the Non-secure developer.

2. When the Secure Bundle Selection window opens, choose the secure bundle obtained from the Secure

developer.

This step is a key difference between Combined Project Development and Split Project Development

process.

The Secure Bundle contains the following information to allow Non-secure project development:

— MCU startup code

— TrustZone boundary configuration information
— Details of locked Secure peripherals configuration settings
— User-defined Non-secure Callable API interface header file (refer to section 3.3)

@ Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —

Preceding Project or Smart Bundle Selection

(O Preceding Project:

@ Smart Bundle:

Choose this option if you have access to the preceding TrustZone Secure Project source code, A debug configuration for
Secure Software Debug (550 state will be generated and both secure and non-secure images will be downloaded to
the target device, Should you wish to test Non-Secure Software Debug (NSECSD) state, use the Renesas Device Partition
Manager to change the Device Lifecycle state as needed.

K_2024\fsp_v5.0.0\porting\app_trustzone\release_5.4.0\ws_1 \bare,metaLm|n|maLs\DEbLi\bareimetalimihimalis.sbd ‘I

Resolved location:
Workspace... File System... Variables...

Choose this option if you only have access to a pre-programmed device containing TrustZone secure code. The Smart
Bundle file (*sbd) should be obtained from the TrustZone Secure Project developer. A debug configuration for
Non-Secure Software Debug (NSECSD) state will be generated and only the non-secure code image will be
downloaded to the target device.

Preceding Project/Smart Bundle Details

FSP version
Toolchain
Toolchain version
Board

Device

Core

Zones

54.0

GNU ARM Embedded
13.21arm-13-7
EK-RASM1
R7FASM1AHECBD
CMm85

CM85_S

)
@

< Back Finish Cancel

Figure 49. Create Linkage to Secure Bundle
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Note: The Secure Bundle is linked in with an absolute path. Verify the Secure Bundle linkage whenever the
folder location of the <project name>.sbd changes.

Follow the prompts to define RTOS usage and select the template project. Once the project is generated,
double click configuration.xml to open the smart configurator. Click Generate Project Content and
compile the project.

Q new_ws - bare_metal_minimurm_ns/src/hal_entry.c - & studio — m} >

File Edit Source Refactor MNavigate Search Project Renesas Views Run  Window Help

4 Debug [£7 bare_metal_minimurn_ns Debug_t - | B/ 5 | - Q-

- PiF g~ hd == v| [a) Q, i | F@ C/C++ {24 FSP Configuration
5 Project Explorer 53 = G Y & = O 8 [bare_metal_minimum_ns] FSP Configuration hal_entry.c 52 = 0™ 0§
~ =% bare_metal_minimum_ns 1 #include "hal_data.h" A

g(;b Binaries 2

7 Includes 3 FSP_CPP_HEADER

(e = void R_BSP_WarmStart(bsp_warm_start_event_t event); =

B 5 FSP_CPP_FOOTER

2 ra_gen &

22 src @& * main() is generated by the RA Configuration editor and is

(= Debug =wvoid hal_entry(void) {

= ra_cfg : add your own code here */

= #if BSP_TZ_SECURE_BUILD
/* Enter non-secure code */
R_BSP_NonSecureEnter();

script
I =| bare_metal_minimum_ns Debug_NSECSD.\aunchl

sor configuration.saml #endif
[E] RTFABMAAFICFE.pincfg }
Devel Assist: . . . . . .
(® Developer Assistance L2} @ * This function is called at various points during the starti ¥
< > < >
Hrz ™ = B [&PinConflicts & Console 53 &4 4|5 BB BB % | *B-5-= 8
| & T &  CDT Build Console [bare_metal_minimum_ns]
: dim=riurne-eduL-ou Juupy -u si'ec pdi'e_meLdl_ImLriLmum_ns.exl vdre_meLdl INLTILINUIN_M1> . 5170 A
Property V arm-none-eabi-size --format=berkeley "bare_metal minimum_ns.elf"

text data bss

dec

hex filename

Figure 50. Compilation Result of Non RTOS Bare-Metal Minimum Non-secure Project Template

Notice that <project name> <build configuration> NSECSD.launch is generated as the
development is carried out in the OEM_PL1 state.

4.2.3.1 Debug the Non-secure Project

Prior to debugging the Non-secure project, ensure that the Secure binary as well as the dummy Non-secure
binary are programmed on the MCU.

During Non-secure project debugging, only the Non-secure .e1f file will be downloaded. There is only the
Non-secure project visible in the workspace for the Non-secure developer as opposed to both Secure and
Non-secure projects being visible with the Combined Project Development.
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@ new_ws - bare_metal_minimum_ns/src/hal_entry.c - & studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

.|| - s || Ne Launch Cenfigurations v | o |- 4 g ® -
) &

£5 Project Explorer 51 =

v 125 bare_metal minimum_ns [Debug]
£ Binaries Golnto

01§} [bare_metal_minimum_ns] FSP Confi

New #include “hal |

FSP_CPP_HEADE!
Open in New Window 3 void R_BSP_Wa

3 ra &
L S 5 SP_CPP_FODTE
9 ra_gen Show In Alt+Shift=W >

5l Includes

& s B Copy CirleC —h
(& Debug e e i
& racfg i | 2
= script HK Delete Delete . T2
mumn_ns Debug_NSECSD jlink Source 2 R_BSP_Nong
w Move... aendif
a -pinely Rename. - 2 — ’
(@ Developer Assistance . 8 = This funckl
Import... - void R_BSP_Wa
o : =i (asP v =% bare_metal_minimum_ns [Debug]
S BponFSP Project. : g e 1%, Binaries
() Export FSP User Pack.. En =
R_FAC ) Includes
Build Project Py
& ra
Clean Project o o
Refresh £ s Fendif 2 ra_gen
Close Project . } & src
e Unrelated Project 37 if (BSP I (= Debug
Build Targets > b = ra_cfg
. Index s i (= script
Build Configurations > §
[C] Properties 53 (5] Problems @ SmartBro.. = =
Run s € 1B e AN Liarrhsrare Pork e e - .

5 7 1 GO Simuiator Debugging (R-850) = bare_metal_minimum_ns Debug_NSECSD.launch
bare_metal minimum_ns - FYF =TI, ; 10¢ configuration.xml
Resource  Property Team > [ 3Renesas GDB Hardware Debugging 5 RTFA6MAAF3CFB. pincfg

Inf ¢ With > - .
v infe R = (@) Developer Assistance
derived Restore from Local Historv... 3

Figure 51. Debug the Non-secure Project
Notes on updating the Secure Bundle:

e If during Non-secure project development, the Secure Bundle needs to be updated, the Non-secure
Developer would need to return the MCU to the Secure Development team for MCU update.

e See section Non-secure Debug in the document FSP User’s Manual section: Primer: Arm® TrustZone®
Project Development section Non-secure Debug to understand how the tools handle protection of the
Secure region when debugging the Non-secure project in the OEM_PL1 Device Lifecycle State.

4.2.3.2 Program the Non-secure Project and Transition to OEM_PLO Device Lifecycle State
This step is for the production flow. It is not normally needed during Non-secure project development.

Once the Non-secure project is fully debugged, the Non-secure binary can be sent to the production line to
program the MCU and transition to the OEM_PLO device lifecycle state. Refer to section 6.3 for operational
details.

See R11ANO0785 (Device Lifecycle Management for RA8 MCUSs) for information about other possible
deployment mechanisms (LCK_BOOT) as well as the state regression methods utilizing the DLM key
through an authenticated procedure.

4.2.4 Production Flow Overview

Refer to section 6 to understand the production flow example. For the Split Project Development Model,
there can be multiple vendors involved in the production flow:

e Secure image handling vendor: the production team programs the Secure image, sets up the TrustZone
boundary, injects the desired DLM and User Keys, and transitions the MCU to the OEM_PL1 state. The
production team also needs to provide the . sbd bundle to the Non-secure application production team.

e Non-secure image handling vendor: the production team programs the Non-secure image and transitions
the MCU to a deployment device lifecycle. See section 4.1.3 for the different possible states.

4.3 Flat Project Development

The Flat Project type in the RA Project Generator refers to the development model in which the developer
does not need to develop the application with TrustZone technology awareness:
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e One single project handles the entire application.

e Development flow is identical to the Non-TrustZone technology part.

e The MCU operates in the OEM_PL2 device lifecycle state.

¢ All peripherals that support Secure and Non-secure attributes will operate in Secure mode.
e Peripherals as identified as Non-secure only in

e Table 4 will operate in Non-secure mode.

4.3.1 Operational Flow

1. Follow Step 1 and Step 2 from section 4.2.1 to start creating the Flat Project template project.

2. Select Flat Project as the project type from the Project Generator.

3. Choose the Build Artifact Selection and RTOS Selection (same interface as in Figure 39).

4. The rest of the development is same as the development for a Non-TrustZone technology enabled
MCUs and is out of scope of this application project.

5. Debug Flat Project.

Debugging the Flat Project follows the Non-TrustZone RA MCU Debugging model. The launch file
named: <program name> <build configuration> Flat.launch.

i Project Explorer £2 = 08 i,'-:} [flat_project] FSP Configuration L] startup.c lc] main.c Z3

=

'* generated main source file - do not edit */
#include "hal_data.h"”
= int main(wvoid)

|
2

~ 1% flat_project [Debug]
g@?‘ Binaries
[t Includes
= ra
2 ra_gen
2 src
== Debug
[= ra_cfg
[= script
Sj-:g configuration.xml
= flat_project Debug_Flat.jlink
S LT N B
5 DleveloperAssistaI:Icr: J |#] Problems B Console 52 @ Smart Browser
CDT Build Console [flat_project]
Extracting support files...
15:18:83 **** Incremental Build of configuration Debug for project flat_project **%*

hal_entry ();
return @;

}

make -j8 all
"Invoking: GNU ARM Cross Print Size'
arm-none-eabi-size --format=berkeley "flat_project.elf™

text data bss dec hex filename

Figure 52. Debug the Flat Project

4.3.2 Production Flow Overview

Production of the Flat Project development model will bring in TrustZone technology awareness. The Flat
Project development is carried out in the MCU lifecycle state OEM_PL2. For production deployment, you
have the same options as the TrustZone technology aware development model: Split Project Development
Model or Combined Project Development Model.

e Option one is to transition the MCU lifecycle state from OEM_PL2 to OEM_PL1, then transition to
OEM_PLO.

— If desired, the MCU lifecycle state can then be transitioned further to LCK_BOOT.
e Option two is to transition the MCU state from OEM directly to LCK_BOOT.

Refer to section 4.1.3 for the different possible states.

5. Example Project for IP Protection

As discussed in section 1.4.1, IP Protection is a strong use case for TrustZone® technology. The project
accompanying this document utilizes the Split Project Development Model to provide an IP protection use
case with EK-RA8ML1 using the e? studio IDE. The Combined Project Development Model is used for the IAR
EWARM and Keil MDK projects.
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5.1 Overview

RA8M1 MCUs can be configured to use an ADC peripheral to monitor the on-chip temperature sensor. This
application project defines an algorithm to control the LED blinking pattern based on the temperature read
from the ADC. The following hardware components are configured as Secure by the Secure project:

e ADC channel for on-chip temperature sensor reading

e GPIO 107, 414, and 600

e TrustZone boundary setup for the Secure flash and Secure SRAM

The following software components are configured as Secure by the Secure project:

e The FSP ADC HAL driver

e The FSP GPIO HAL driver for the corresponding LED driving pins

e The application code that starts, scans, and stops the ADC

e The application code that controls the LED blinking pattern based on the temperature reading

e The API that starts the monitoring and reacting algorithm
— This API is defined as Non-secure Callable API and its veneer is exposed to the Non-secure

partition.

e The API that stops the monitoring and reacting algorithm
— This API is defined as Non-secure Callable API and its veneer is exposed to the Non-secure

partition.

GPIO
ADC
and

API

Code Flash

Customized Application
NSC API

IP Algorithm Veneer

Figure 53. Sensor Algorithm IP Protection
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5.2 System Architecture

5.2.1 Software Components
Figure 54 shows the Secure, Non-secure, and Non-secure Callable hardware and software partition scheme
in this example project.

Color Legend

Non-secure

Callable Partition

Non-secure

Pariition

NSC API Veneer

ai
-

EEEE

Figure 54. Software Architecture Block Diagram
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5.2.2 Operational Flow
Figure 55 shows the system-level operational flow of the example project.

Start

l

Transition to
Mon-secure

World

l

=zer menu selection
received? b

MEC AP

sensor algorit
bm start guard
Veneer

Color Legend

MNon-secure
Callable Partiion
MEC AP

Senszor_algorit
hm_stop_guard
Veneer

MNon-5ecure

Partition

Run Secure Partition
Senzor_algorit
hrn_stop_guard

Figure 55. Operational Flow
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5.2.3 Simulated User’s IP Algorithm
The simulated user’s IP algorithm is described in Figure 56.

Note: In Figure 56, TSN means on-chip Temperature Sensor.

> B
_
<>

Figure 56. Simulated Sensor IP Algorithms (Running in Secure Partition)

5.2.4 User-Defined Non-secure Callable APIs

The Non-secure callable functions exposed to the Non-secure partition are defined in
sensor algorithm nsc.h from the Secure project.

®| * File Name : sensor_algorithm_nsc.h[]
@ * DISCLAIMER[]
= #ifndef SENSOR_ALGORITHM NSC_H_

#define SENSOR_ALGORITHM_NSC_H_

#include <hal_data.h>

BSP_CMSE_NONSECURE_ENTRY void sensor_algorithm_start_guard{void);
BSP_CMSE_NONSECURE_ENTRY woid sensor_algorithm_stop_guard(void);

#endif /* SENSOR_ALGORITHM_NSC_H_ */

Figure 57. User-Defined NSC APIs

To share the user-defined NSC calls, this header file is linked to e? studio by a Build Variable.
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The path to this header file is added using the Build Variable UserNscApiFiles as shown in Figure 58.

& Properties for pre_programmed_sensor_algorithm_s O X
type filter text Build Variables v §
Resource
Builders
~ C/C++ Build Configuration: |Debug [Active ] ~ | Manage Configurations...

Build Variables
Environment

Logagin
Se?tigngf MName Type Value Add...
Tool Chain Editor UserNscApiFiles File List $iworkspace_loc/pre_programmed_sensor_algorithm_s/src/sensor_algorithm_nsc.h} Edit..
C/C++ General
Project Natures DiEs
Project References
Renesas QF
Run/Debug Settings
Task Tags
Validation
[]Show system variables
Build Variables are IDE only variables, which can be used for string substitution when defining external builder configuration, such as
environment variable value or command line parameter in form of ${VAR}, internal builder may use them directly.
Restore Defaults Apply
? Apply and Close Cancel

Figure 58. User Build Variable to Link User NSC Header File (Secure Project Setting) in e? studio

The Build Variable approach does not exist when using IAR EWARM and Keil MDK; you need to manually
share this header file with the Non-secure project. This is demonstrated in the included IAR EWARM and
Keil MDK example project.

5.3 Setting up Hardware

¢ Jumper setting — default EK-RA8M1 setting
— See EK-RA8M1 User’s Manual.

e Connect J10 using USB macro to B cable from EK-RA8ML1 to the development PC to provide power and
debugging capability using the on-board debugger.

Initialize the MCU

This step is optional but recommended. Prior to downloading the example application, it is recommended to
initialize the device to the OEM_PL2 state. Unlocked flash content will be erased during this process. This
step can be achieved using the RDPM or RFP. This is particularly helpful if the device was previously used in
the OEM_PL1 state or has a certain flash block locked up temporarily.

For instructions on how to use RFP to perform this function, see section 6.1.
Use RDPM and J-Link Debugger to initialize the MCU.

Establish the following connection prior to using the RDPM and the Onboard J-Link debugger to perform
Initialize device back to factory default. Note that Initialize device back to factory default performs the
same functionality as Initialize Device when using RFP:

o EK-RA8ML1 jumper setting: J6 closed, J9 open. Other jumpers keep out-of-box setting.
e USB cable connected between J10 and development PC
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Note: You must power cycle the board prior to working with the RDPM after a debug session if using J-Link
as connection interface.

Open RDPM

Run Renesas Al Window Help

Renesas Debug Tools > Renesas Device Partition Manager
Q. Run Cri+F11 [ TraceX >
_‘ﬁf. Debug F11 @l Tracealyzer >

r

Figure 59. Open the RDPM

Next, check Initialize device back to factory default, choose the connection method, then click Run.

Q Renesas Device Partition Manager O X
(D Enter a value for Action and Emulator type
)
Device Family: |Renesas RA
Action
Read current device information Change debug state
Set TrustZone secure / non-secure boundaries Initialize device back to factory default
Target MCU connection: J-Link v
Connection Type: ISCI VI
Emulator Connection: Serial No v
Serial No/IP Address: | |
Debugger supply voltage (V): 0
Connection Speed (bps for SCI, Hz for SWD}: 9600
Debug state to change to: Secure Software Development
Memory partition sizes
[] Use Renesas Partition Data file
Browse...
Code Flash Secure (KB) 32
Code Flash NSC (KB) 0
Data Flash Secure (KB) 0
SRAM Secure (KB) 8
SRAM MNSC (KB) 0
[ 1 ¥
Show Command Line Run
'?\ @ @ Close

Figure 60. Initialize RA8M1 using RDPM

After the MCU is initialized, proceed to the project importing and verification based on the IDE selected.
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5.4 Example Application with e? studio IDE using Split Project Development Model

The €2 studio project utilizes the Split Project Development Model to establish an application for IP

protection. The assumption is that the Secure and Non-secure applications are developed by separate
teams.

5.4.1 Import, Build, and Program the Secure Binary and Dummy Non-secure Binary
Use the following steps to provision the MCU with the Secure binary and a dummy Non-secure binary.

5.4.1.1 Import the Secure Project and Dummy Non-secure Project

Unzip e2studio. zip, which is included in this application project, to reveal the folders shown in Figure 61.

non_secure_project

secure_project_and_dummy_ns_project
T pre_programmed_sensor_algorithm_dummy _ns

pre_programmed_sensor_algorithm_s

Figure 61. e2studio Software Project Content

Next, follow FSP User’s Manual section, Importing an Existing Project into e2 studio to import the Secure
project and the dummy Non-secure project into the same workspace.

&) Import O x
Import Projects S

Select a directory to search for existing Eclipse projects. “
@ Select root directory: \e2studio\secure_project_and_dummy_ns_project - |I Browse...
(O Select archive file: Browse...
Projects:

O\e2studio\secure_project_and_dummy_ns_project\pre_programmed_sensor_algorithm_dummy_ns) Select All
p\secure_project_and_dummy_ns_project\pre_programmed_sensor_algorithm_s)

Deselect All
Refresh

< >

Options

[]search for nested projects

[[] Copy projects into workspace

[ Close newly imported projects upon completion

[JHide projects that already exist in the workspace

Working sets

[[] Add project to working sets New...

Select...
'.'_?_',' = Back Next = Cancel
Figure 62. Import the Secure Project and Dummy Non-secure Project
Click Finish.
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5.4.1.2 Compile the Secure Binary and Dummy Non-secure Binary using e? studio

e Compile the Secure project first. Double click to open the configuration.xml in the Secure project.
Click Generation Project Content. Compile the Secure project. Ensure
pre programmed sensor algorithm s.srec and
pre programmed sensor algorithm s.sbdare generated.

e Next, compile the Dummy Non-secure project. Double click to open the configuration.xml in the
Dummy Non-secure project. Click Generate Project Content. Compile the Non-secure project. Ensure
pre programmed sensor algorithm dummy ns.srec is generated.

5.4.1.3 Download the Secure Binary and Dummy Non-secure Binary using e2 studio
Prior to downloading and running the example project, user should first follow section 5.3 to set up the MCU.

Right-click on the pre programmed sensor algorithm dummy ns project and select Debug As >
Renesas GDB Hardware Debug. Click Resume twice to run the Secure and dummy Non-secure project.
Click Pause and confirm the execution pauses at the while (true) loop inthe hal entry () function in
hal entry.c of the dummy Non-secure project.

- void hal_entry(wvoid)

1
/* : add vour own code here */
while(true);

- #ilf BSP_TZ SECURE_BUILD

/* Enter non-secure code */
R_BSP_NonSecureEnter();

#endif

I

Figure 63. Program and Run the Secure and Dummy Non-secure Projects

Stop the debug session.

R11ANO897EU0100 Rev.1.00 Page 52 of 75
Nov.13.24 RENESAS




Renesas RA Family Security Design using Arm TrustZone - Cortex M85

5.4.1.4 Transition MCU Device Lifecycle State to OEM_PL1

After both the Secure binary and dummy Non-secure binary are downloaded to the MCU, you can use the
RDPM to transition the MCU from the OEM_PL?2 device lifecycle state to the OEM_PL1 device lifecycle
state.

First, power cycle the board. Next, launch RDPM and configure to transit to OEM_PL1.

8 Renesas Device Partition Manager O >

Device Family: Renesas RA

Action
[JRead current device information | Change debug state I

[]set TrustZone secure / non-secure boundaries [_] Initialize device back to factory default

Target MCU connection: J-Link e
Connection Type: SCl ™
Emulator Connection: Serial No v

Serial No/IP Address:

Debugger supply voltage (V): 0

Connection Speed (bps for SCl, Hz for SWD): 19600

Debug state to change to: Non-secure Software Development

Memary partition sizes

[JUse Renesas Partition Data file

Browse...

Code Flash Secure (KB) 0

Code Flash NSC (KB) 0

Data Flash Secure (KB) 0

SRAM Secure (KB) 0

SRAM NSC (KB) 0

W
Show Command Line Run
'? u @ Close
Figure 64. Transition from PL2 to PL1 using RDPM

Click Run and ensure the transition is successful.
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Connecting... ~
Loading library : SUCCESSFUL!
Establishing connection : SUCCESSFUL!
Checking the device's TrustZone type  : SUCCESSFUL!

COMNMNECTED.

Transitioning Protection Level (PL).. X
Current Protection Level (PL) : PL2

Target Protection Level (PL) : PL1
SUCCESSFUL!

Disconnecting...
DISCONMNECTED.

Connection : SUCCESSFUL!
DLM transition : SUCCESSFUL!

Figure 65. Result: Transition from PL2 to PL1

Refer to section 6.1 and section 6.2 for the operational steps of downloading the Secure binary and setting
up the TrustZone boundary using RFP during production stage.

5.4.2 Import, Build, and Program the Non-secure Project
Once the DLM transitions to PL1, you can proceed to download the real Non-secure project.
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5.4.2.1 Import the Non-secure Project

Follow the ESP User’s Manual section, Importing an Existing Project into e? studio to import the Non-secure

project into the workspace. You can import into the workspace where the Secure project is imported for
purpose of verifying the example project.

& import O x
Import Projects —
Select a directory to search for existing Eclipse projects. 5'. ‘
@ Select root directory: a\reIease_5.4.D\e2studio\non_secure_projecﬂ e Browse...
() Select archive file: Browse...
Projects:
b.4.0\e2studio\non_secure_project\pre_programmed_sensor_algorithm_ns) Select All
Deselect All
Refresh
< >
Options

[1Search for nested projects
] Copy projects into workspace
[ Close newly imported projects upon completion

[ Hide projects that already exist in the workspace

Working sets

[ Add project to working sets MNew...

Select...

'?\ < Back Next = Cancel

Figure 66. Import the Non-secure Project

Note: You must update the Build Variable SecureBundle by selecting the

pre programmed sensor algorithm s.sbd based on your local file structure, prior to moving
forward to the other steps. This is a limitation with the current tools.
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& Properties for pre_programmed_sensor_algorithm_ns m] x

type filter text Build Variables v §

Resource

Builders
~ C/C++ Build Configuration: |Debug [ Active ] ~  Manage Configurations...

l Build Variables

nvironmen

Logging

Settings

Tool Chain Editor
C/C++ General 2
Project Natures "
Project References
Renesas QE
Run/Debug Settings
Task Tags
Validation

Name Type Value
File e2studio\secure_pro,

e
2
9.

Delete

< >

[ Show system variables

Build Variables are IDE only variables, which can be used for string substitution when defining external builder configuration, such as environment variable value or command
line parameter in form of ${VAR}, internal builder may use them directly.

Restore Defaults Apply

Apply and Close Cancel

Q Properties for pre_programmed_sensor_algorithm_ns O X
type filter text Build Variables MR
Resource
Builders
~ C/C++ Build Configuration: Debug [ Active ] ~ | Manage Configurations...

Build Variables

Environment

Logging

Settings gddz

Tool Chain Editor
C/C++ General
Project Natures 4
Project References
Renesas QF
Run/Debug Settings
Task Tags
Validation

\se(urejmJert_and_dummy_nsJijecl\preJJmgrammed_sensm_aIgorlthm_s\Debug\preJJmglammed_sensor_algmithm_s‘sbd I Edit
it...

Delete

< >

[ Show system variables

Build Variables are IDE only variables, which can be used for string substitution when defining external builder configuration, such as environment variable value or command
line parameter in form of ${VAR}, internal builder may use them directly.

Restore Defaults Apply

'\?\‘ 5. ||Apply and Close Cancel

Figure 67. Referencing the Secure Bundle
5.4.2.2 Compile and Download the Non-secure Project

e Double click to open the configuration.xml in the Non-secure project. Click Generation Project
Content. Compile the Non-secure project.
e Download and run the Non-secure project.
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= g o=

L5 Project Explorer X =Rk & | =
IV =] pre_programmed_sensor_algorithm_ns [Debug I New 5
3 Binaries Go Into
! Includes . .
- Open in New Window
Era .
o Show In Alt+Shift+W >
- ra_gen Show in Local Terminal >
(2 src
(= Debug =] Copy Ctrl+C
& build Paste Ctrl+V
(= racfg *K Delete Delete
(= script Source t/
45 configurationxml slere=
| JlinkLog.log Betduies L2
u pre_programmed_sensor_algorithm_ns Debug [y Import.
X pre_programmed_sensor_algorithm_ns Debug | Export...
(7) Developer Assistance Renesas FSP Export >
Build Project
Clean Project
Refresh F5
Close Project
Close Unrelated Project
Build Targets >
Index >
Build Configurations >
Source >
O Runas >
l!t‘\:- Debug As >|E—=1 1 GDB OpenOCD Hardware Debugging (DSF)
eam [c7| 2 GDB Simulator Debugging (RH850)
Compare With > [E] 3Llocal C/C++ADD@on
Restore from Local History... ©7 4 Renesas GDB Hardware Debugging
MISRA-C > ™ 5 Renesas Simulator Debugging (RX, RL78)
4% C/C++ Project Settings Ctrl +Alt+P . .
Renesas C/C++ Project Settings Debug Configurations.. . )
H Run C/C++ Code Analusic [£7] 6 pre_programmed_sensor_algorithm_ns Debug_NSECSD (Renesas GDB Hardware Debugging)
Figure 68. Download and Run the Non-secure Project
Note: For the Split Project Development model, the debug session of the Non-secure project created by
referencing the Secure Bundle rather than the Secure Project (as with the case for the dummy Non-
secure project) only downloads the .e1f file of the Non-secure project.
5.4.3 Verify the Example Application
The projects are now loaded, and the debugger should be paused in the Reset Handler () atthe
SystemInit () call in the Non-secure project.
%5 Debug X = ‘i%' § = 0|9 startup.c > = 0
v ] pre_programmed_sensor_algorithm_ns Debug_NSECSD [Rene ~
v T‘; pre_programmed_sensor_algorithm_ns.elf [1] [cores: 0] ® * Exported global variables (to be accessed by other files)[]
~ o Thread #1 1 (single core) [core: 0] (Suspended : Signal : “ . . .
= Reset_Handler() at startup.c:50 Ox12008ddc ® * Private global variables and functiond[]
; B void Reset_Handler(void);
- arm-none-eabi-gdb (12.1) void Default_Handler(void);
»| Renesas GDB server (Host) int32_t main(void);
® * MCU starts executing here out of reset. Main stack pointer is set up alre
= BSP_SECTION_FLASH_GAP void Reset_Handler (void)
{
/* Initialize system using BSP. */
12008ddc SystemInit();
/* Call user application. */
12008de2 main();
12008de6 = while (1)
/* Infinite Loop. */
}
Figure 69. Running the Non-secure Project
Open the J-Link RTT Viewer 7.96j. First, click “...” and select R7TFA8M1AH from Renesas as the Target
Device. Next, set the connection to J-Link to Existing Session and the RTT Control Block to Search
Range. Set the search range to 0x32000000 0XxEOO00 and then click OK to start RTT Viewer. Note the the
RTT related embedded code is in the Non-secure application and the RTT buffer address is using the Non-
secure alias address with bit 28 set to 1.
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E! J-Link RTT Viewer V7.96j | Configuration x
Connection to J-Link

() use

() TCr/IP

@ Existing Session | Auto Reconnect

[] use non-default port

Specify Target Device

I r7rasM1AH | D

Force go on connect

Script file (optional)

Target Interface & Speed

SWD 4000 kHz
RTT Control Block

() Auto Detection () Address (@ search Range

Enter one or more address range(s) the RTT Control block can be located in.
Syntax: <RangeStart [Hex]> <RangeSize=[, <RangelStart [Hex]> <RangelSize=, ...]
Example: 0x10000000 0x1000, 0x2000000 0x1000

0x32000000 0OxEOOOO |

Figure 70. Start the RTT Viewer

Next, click Lg twice to run the project.

The user menu is then output, and the system waits for user input.

File Terminals Input Logging Help

All Terminals Terminal 0 Terminal 1

system Reset, enter non-secure region

rt the IP Algorithm
top the IP Algorithm

Figure 71. User Menu
Input 1 to start the IP algorithm. You will see the green LED start to blink after couple of seconds.

You can warm up the MCU (for example, touch the MCU using grouped fingers) and see that the green LED
stops blinking and the red LED starts to blink after about 1 minutes.

Start IP Algorithm

If temperature did not change more than threshold, the Green LED will blink
If temperature changed more than threshold, the Red LED will blink

Figure 72. User Input ‘1’

Input 2 to stop the IP algorithm. The green or red LED stops blinking. The blue LED blinks twice and stops
blinking.
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@8> Stop_IP_Algorithm

@8> Blue LED will toggle twice
@8> Press 1 to restart the IP Algorithm

Figure 73. User Input 2’

You can repeatedly input 1 to restart the IP algorithm and input 2 to stop.

Notes on Running the Application in Standalone Mode

After the MCU is programmed with the application code, you can run the application in standalone mode

(with no debugging session). In this case, choose USB as the Connection to J-Link.

J-Link RTT Viewer Configuration X
Connection to J-Link

(® UsB [ | serial No

O TepIp

O Existing Session
Specify Target Device
[R7FABM1AH v

|:| Force go on connect
Script file (optional)

Target Interface & Speed
SWD v 4000 kHz -~

RTT Control Block

(O) Auto Detection (O Address (®) Search Range

Enter one or more address range(s) the RTT Control block can be located in.
Syntax: <RangeStart [Hex]> <RangeSize>[, <RangelStart [Hex]> <RangelSize>, ...]
Example: 0x10000000 0x1000, 0x2000000 0x1000

Jo:32000000 0xE0000 | |
——————

Figure 74. SEGGER RTT Viewer Connection Setup when MCU Running in Standalone Mode

5.5 Example Application with IAR EWARM using Combined Development Model

The IAR based projects use the Combined Development model. The assumption is that the Secure and Non-
secure applications are developed by one team.

Unzip IAR. zip to explore the IAR project contents.

. sensor_algerithm_ns File folder
Non-secure project <
sensor_algorithm_s File folder
Secure project < settings File folder
Workspace File  «———— e sensor_algerithm AR IDE Workspace
.| sensor_algerithm.custom_argvars CUSTOM_ARGVARS File

Figure 75. IAR EWARM Software Project Content
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5.5.1 Import and Build the Example Projects
Use the following steps to build the IAR example project:

1. Double-click on \IAR\sensor trustzone.eww to launch the IAR EWARM. There are two projects in
this workspace. Click on the Secure project \sensor s to make it the active project.

2. Notice that the header file sensor algorithm nsc.h, which includes the user-defined NSC functions,
is included in both the Secure project and Non-secure project.

3. Select Tools > RA Smart Configurator.

> sensor_trustzone - IAR Embedded Workbench IDE - Arm
File Edit View Project J-Link | Tools | Window Help

00 el - i) [] & Options.. KQ>%*»2<0 >0 B@®-=0 "> _ids.

Workspace Filename Extensions... ns.h | common_utils.h  startup.c  sensor_ns.map sensor_ns.out sensor_algor|

sensor_ns - Debug Configure Viewers..,

sk ok s ok ok S o R o ok o o o R ok Kk ok KR S oK oK KR oK oK SRR SR R SR o R R S R S R R ok Rk o R

Files Configure Custom Argument Variables... . sensor_algorithm nsc.h
b _ 1_nsc.
B M sensor trustzone /s Configure Toals... : contains non-secure callable API interfaces
l_E] . - _D b = Bk sk ok sk sk ok ke e o sk sk sk sk 3k ok sk ok ok ok ke s sk sk sk ok sk sk ok sk sk ok ok ke ok ok sk ok sk ok sk sk sk ok sk sk ok ke ok sk sk ok sk ok ok sk ok ok ko
| 25E|sm§n$tw ebug IAR Project Converter e o ok ok sk ok ok ok of ok o oF o o oF o 3% ok Sk of Sk St ok o o F o o 3K ok o ok ok of ok of o S o 3K oK oF 3R ok of ok of ok ok of ok R R R
+ Ex oomiare
!—D B buildinfo.ipct m RA Smart Configurator > is supplied by Renesas Electronics Corporation and is only
- @ sensor_s - Debug : ~e authorized. This software is owned by Renesas Electronics
Flex Softw Smart Bundle Viewer - - >
= . lex .D are_ _ . - aws, 1including copyright laws.
Bl Build Configuration Device Partition Manager © IS PROVIDED "AS IS" AND RENESAS MAKES NO WARRANTIES REGARDI
B Components - 1H1> >Ur IWAKE, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING BUT NOT L

Bl Generated Data

L IProgramEntry [ |
F— B hal_entry.c
I— sensor_algonthm_nsc.c
B sensor_algornthm_nsc.h

— B buildinfo.ipct

* FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. ALL SUCH WARRANTIE
* EXTENT PERMITTED NOT PROHIBITED BY LAW, NEITHER RENESAS ELECTRONICS CORP(
* SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUE
* SOFTWARE, EVEN IF RENESAS OR ITS AFFILIATES HAVE BEEN ADVISED OF THE POSS
* Renesas reserves the right, without notice, to make changes to this softu
* this software. By using this software, you agree to the additional terms
* following Llink:

* http://www.renesas.com/disclaimer

Figure 76. Launch RA Smart Configurator from IAR

4. Once the RA Smart Configurator is launched, click Generate Project Content.

5. Close the RA Smart Configurator.

6. Return to the EWARM IDE, right-click on sensor_s and select Rebuild All. The Secure project will be
compiled.

7. Select the Non-secure project sensor ns to make it the active project.

8. Select Tools > RA Smart Configurator.

9. Click Generate Project Content.

10. Return to the EWARM IDE and check if there is a \Objects folder under \Flex Software and
secure.o exists in the \Objects folder. If yes, the non-secure project will compile with no issue. If no,
then the non-secure project will need to be compiled twice. The first compile may issue an error

message similar to Figure 78. The second compile process will succeed. This is because there is a
timing issue between EWARM and RSAC operation.

FES W
=) lsensor_ns-Debug [ V]
£ 8 Flex Software

Bl Build Canfiguration

B Compaonents

B Generated Data

—E1 Bl Ohjects

L— Msecureo

— Bl Program Entry

Figure 77. Check that the secure.o is included in the project

R11ANO897EU0100 Rev.1.00 Page 60 of 75
Nov.13.24 RENESAS




Renesas RA Family

Security Design using Arm TrustZone - Cortex M85

SRIEUI_IIS.UUL

#23 Error[Li005]: no definition for "sensor_algorithm_stan_guard” [referenced from CATrustZone_|AR_Keilkeilk2 contentAR\sensor_ns\DebughObj\Flex SoftwarelProgram Entndhal_entry.o)
#23 Error{Li005]: no definition for "sensor_algorithm_stop_guard" [referenced from CATrustZone_lAR_Keil\keilK2 contentlAR\sensor_ns\DebughObj\Flex SoftwarehFrogram EntnAhal_entry.o]

Figure 78. Potential Error Message

5.5.2 Download and Debug the Application Projects
Prior to downloading and running the example project, user should first follow section 5.3 to set up the MCU.

Then, use the following steps:

1. Click on the Project tab Project > Options > Debugger > Setup and notice that
partition device.mac is selected. This macro defines the TrustZone boundary setting generated.

2. Switch to the Debugger > Download window and notice that the Secure image is also downloaded.

Category:

General Options
Static Analysis
Runtime Checking
C/C++ Compiler
Assembler
Output Converter
Custom Build
Build Actions
Linker
Simulator
CADI
CMSIS DAP
GDB Server
I-jet
J-Link/J-Trace
TI Stellaris
Nu-Link
PE micro
ST-LINK
Third-Party Driver
TI MSP-FET
TI XDS

Options for node "sensor_algorithm_ns"

X

Setup

[v] Download extra image

Factory Settings

Download |mages Multicore Extra Options Plugins

Path:

ensor_algorithm_s\Debug\Exl\sensor_algcﬁthm_s‘oui I

Offset: 0

[] Debug info only

[ Download extra image

Debug info only

[ Download extra image

Debug info only

Cancel

Figure 79. Non-secure Project Debug Configuration to Download the Secure Project

3. Click Download and Debug
4.

o .

If the current MCU TrustZone boundary differs from the boundary calculated from the Secure project, the

window shown in Figure 80 will appear, prompting you to set up the TrustZone boundary.

——

|

Launch the Renesas Device Partition Manager tool?

Yes No

':9:' Target device needs TrustZone partition sizes to be changed before debug session can be started.

Figure 80. Select Launch RDPM
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Once the RDPM is launched, configure the settings as shown in Figure 81. Use Browse to select
the .rpd file generated from the secure project (sensor s.rpd) as the input for the User Renesas

Partition Data file entry.

Device Family: Renesas RA ~

Action

[ Read current device information

Target MCU connection:
Connection Type:
Emulator Connection:
Serial No/IP Address:

Debugger supply voltage (V):

Debug state to change to:
Memory partition sizes

se Renesas Partition Data file

B ' Renesas Device Partition Manager

Bet TrustZone secure / non-secure boundaries [ ] Initialize device back to factory default

Connection Speed (bps for SCI, Hz for SWD): 9600

[JChange debug state

J-Link
SCI

Serial No

]

0

Secure Software Development

IDebug\Exe\sensosz.rpd I Browse...

Code Flash Secure (KB) 32
Code Flash NSC (KB) 0
Data Flash Secure (KB) 0
SRAM Secure (KB) 8
SRAM NSC (KB) 0

[JCommand line tool:

C:\Users\trung.tran-quoc\.eclipse\com.renesas.platform_219473157\DebugComp\RA\D¢ |Browse...

Import

Close

Export

Figure 81. Configure the RDPM
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5. Click Run to set up the TrustZone boundary.

B ' Renesas Device Partition Manager

Emulator Connection:
Serial No/IP Address:

Debugger supply voltage (V):

Debug state to change to:
Memory partition sizes

Use Renesas Partition Data file

Connection Speed (bps for SCI, Hz for SWD): 9600

~

Serial No

[ ]

0

Secure Software Development

‘\Debug\Exe\sensorﬁs.rpd| |Br0wse...

Code Flash Secure (KB)
Code Flash NSC (KB)
Data Flash Secure (KB)
SRAM Secure (KB)

SRAM NSC (KB)

[[1Command line tool:

C:\Users\trung.tran-quoc\.eclipse\com.renesas.platform_219473157\DebugComp\RA\DevicePartitionMan

32

Browse...

Connecting...
Loading library
Establishing connection

CONNECTED.

Checking the device's TrustZone type

: SUCCESSFUL!
: SUCCESSFUL!
: SUCCESSFUL!

Code Flash Secure (kB)
Data Flash Secure (kB)
SUCCESSFUL!

0

Programming secure/non-secure memory partitions with the following settings...
132

Disconnecting...
DISCONNECTED.

: SUCCESSFUL!
- SUCCESSFUL!

Connection
Partition setting

Import Export Close

Figure 82. TrustZone Boundary is Set up using RDPM

Navigate to the EWARM IDE, click Download and Debug ) , to program the Secure and Non-secure

to resume the

6. Click Close to close the RDPM.

7.
applications. When the execution stops at Reset_Handler, click the Go button
execution.

8. See section 5.4.3 to verify the functionality of the project.

5.6 Example Application with Keil MDK using Combined Development Model

The Keil MDK based projects utilizes the Combined Development model. The assumption is that the Secure
and Non-secure applications are developed by one team.
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Unzip Keil.zip to explore the IAR project contents.

Non-secure project «——

-~

Secure project secure

non_secure

Keil workspace file <«—— [ sensor trustzone

Figure 83. Keil MDK Software Project Content

5.6.1 Import and Build the Example Projects
Follow the steps below to build the Keil example projects:

1. Launch Keil MDK with Administrator authority. Right click on

K2 uws

and select Run as administrator.

2. Open the multi-project Workspace sensor trustzone.uvmpw.
X
C » (C)Windows » TrustZone |AR » Keil W [V] Search Keil yl
= O @
) Mare Date modified Type Size
non_secure File folder
ML, File folder
ﬂ sensor_trustzone.uvmpw pVision Multi-Praj...
v o< >
E: |senser_trustzone.uvmpw v| All Files (*%) ~
| Open | Cancel

Figure 84. Open the Keil Multi-project Workspace

3. Setthe sensor_s as the Active Project and then launch the RA Smart Configurator.

File Edit View Project Flash Debug Peripherals

& d @ @ | | ®
@mm@’ -‘Lispl‘farget‘l ~
Project

o WorkSpace
=% Project: sensor_s
-l 40 Target1
+ {d Source Group 1
@ [d Renesas RA Smart Configurator.Common
@9 Flex Software

KA C:\TrustZone_|AR _Keil\Keil_K2_Folder\Keil\secure\sensor_s.uvprojx - pVision

Tools
Set-up PC-Lint...
Lint

Lint All C/C++ S

Configure Merg

Customize Tools Menu...

SVCS  Window Help

ource Files

e Tool...

RA Smart Configurator

Smart Bundle Viewer

Device Partition

=% Proiect: sensor ns

T

St
I IG(
=M
it
Manager
1490 | INII

Figure 85. Launch RA Smart Configurator from Keil MDK
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4. Once the RA Smart Configurator is launched, click Generate Project Content.
5. Close the RA Smart Configurator.
6. Return to the MDK IDE, click Project > Build ‘sensor_s’.

File Edit View Project Flash Debug Peripherals Tools SVCS Wil
=" él Mew pVision Project
” " Mew Multi-Project Workspace...
S EE @
Open Project...

Project
= Close Project
= A WerkSpace
=% Project: Import
= 4% Targe Export
o= I Manage
=N
& F Select Device for Target ..
59 Project: Remove Item

= & Targi A% Options for sensor_s - Target ‘Target 1'..

Clean ‘sensor.s (Target 1)

Build ‘sensor_s (Target 1)

Rebuild 'sensor_s (Target 1)°
18 Batch Build

Figure 86. Build the Secure Project

The Secure project will be compiled.
Follow section 5.3 to set up the MCU.

© N

9. Set the TrustZone boundary using the sensor_s.rpd file generated during the compilation process in a
similar way as shown in Figure 81.

10. Ensure that the TrustZone Boundary is successfully set up.

Connecting.. ~
Loading library SUCCESSFUL!
Establishing connection : SUCCESSFUL!
Checking the device's TrustZone type SUCCESSFUL!

CONNECTED.

Programming secure/non-secure memory partitions with the following settings...
Code Flash Secure(kB) - 32
Data Flash Secure (kB) -0

SUCCESSFUL!

Discannecting...
DISCONNECTED

SUMMARY OF RESULT
Connection SUCCESSFUL!
Partition setting : SUCCESSFUL!

@
@ impor Erpor Close

Figure 87. TrustZone Boundary is Configured Correctly
11. Close the RDPM.

12. Right click on the Non-secure project sensor ns and set it is as the Active Project.

File Edit View Project Flash Debug Peripherals Tools SVCS Wi

IR Y | = | £5
\é/)\ﬂm&@/' ‘Linn&o‘TargeH v}a\‘ﬁ%‘
Project L |
= EA WorkSpace H

o Reetenes
= %7 Target1
@#-Ld Source Group 1
+-L1 Renesas RA Smart Configurator:Common Sources
@ ¥ Flex Software
=% Project: sensor_ns
E %7 Target 1 I Set as Active Project l I

B Caiiern Cencin 1

Figure 88. Set the Non-secure Project as the Active Project
13. Select Tools > RA Smart Configurator.
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14. Click Generate Project Content.
15. Close the RA Smart Configurator
16. Return to the Keil MDK IDE and select Project > Build ‘sensor_ns’.

File Edit View Project Flash Debug Peripherals Tools SVCS Window

=" ﬂ} New pVision Project..
:: New Multi-Project Workspace...
S e ! ’

Open Project...
Project

Close Project

SRE?) WorkSpace
= % Project: Import
= 47 Targy Export
@ g Manage
=3 R
@ 0 [ Select Device for Target ..
2% Project: Remove ltem

= %3 Targt &\ Options for sensor_ns - Target ‘Target 1'...
= §
@=-03 (¢

Clean ‘sensor_ns (Target 1)’

E

Build ‘sensor_ns (Target 1)’

5

(=R N
Rebuild ‘sensor_ns (Target 1)’

Batch Build

b € B

4

Figure 89. Build the Non-secure Project

17. The non-secure project will compile successfully with no issue.
5.6.2 Download and Debug the Application Project
Follow the steps in this section to debug the system.

1. With sensor ns as the Active Project, click the Start/Stop Debug Session button.

Jae[a-le co e 8- A

@ Start/Stop Debug Session (Ctrl=F5)

Enter or leave a debug session
_] SEGGER RTT.h -~ | ] —

pnction is onlv specified for accesses to RTT buffer O

Figure 90. Start Debug with Keil MDK
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2. Click Run and then follow section 5.4.3 to verify the functionality of the application project.

File Edit View

=N

Registers

Project  Flash Debug

@ |

slajo neo o+ | DR 6= 8-

Peripherals  Tools SVCS  Window  Help

- p

3 Ed Disassembly

Register

= Core

Ri12
R13(5P)
R14 (LR}
R15(PC)
+-4PSR
Banked
Secure
Naon-Secure
Intemnal
Made
Privilege
Stack
States
Sec

1] [ F-F

62: {

63: f* Imitialize system using BSP. */

o4

: SystemInit ()

[7 stattup.c ] halentryc | ] SEGGERRTT.h ] SEGGER_RTT|

61

woid Reset_Handler (void):
woid Default_Handler (void);
int32_t main(void):

void Reset Handler (void)
Elle
/* Imitialize system using BSP. */f
SystemInit ()

f# Call user application. */

main():

while (1)
= {

# Infinite Loop. */

Figure 91. Run the Application Project

3. Follow section 5.4.3 to verify the functionality of the example projects.

6. Appendix A: Using RFP for Production Flow

e Allinstructions in this section are based on connection to RFP using J-Link debugger over USB. For
other connections, refer to the RFP User’s Manual for instructions.

e All the instructions provided in this section are for supporting the production flow of the e? studio example
application explained in section 5.4. The difference in the production operation between Combined
Project Development model and the Split Project Development model will be pointed out. However,
providing detailed instructions on the production flow of the Combined Project Development model is out
of scope of this application project. Users need to adjust these RFP projects with the TrustZone
boundary setup if different projects are used.

6.1 Initialize the MCU

Follow the steps in section 5.3 to establish the hardware connections. Then, launch RFP, open

“\RFP_projects\initialize mculinitialize mcu.rpj”, go to the tab Device Information, and

select Initialize Device.

File | Target Device | Help

operati Read Device Information =h
Read Memory...
Pr Read Flash Options
1
[ initialize Device |
DLM Transition...

Figure 92. Initialize using RFP
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Signature:
Device: R7FASMIAHECED
Boot Firmware Version: V3528
Device Unique ID: 4E4B2E3F5AFI4E36305034352D057494
Device Code: 03
Current state: OEM_PL2
Current Authentication Level: AL2
AL2 Key Injection: No
AL1 Key Injection: No
RM& Key Injection: No

Erasine the target device

Disconnecting the tool
Operation completed. v

Clear status and message

Figure 93. MCU is Successfully Initialized

6.2 Download the Secure Binary

Open the attached RFP project

\RFP_projects\pre programmed sensor algorithm s\pre programmed sensor algorithm
s.rpj to perform the following functions:

e Program the Secure binary.
e Set up TrustZone boundary.
e Transition to OEM_PL1.

Note that the demonstration in this section is based on the configuration in the e? studio projects
demonstrated in section 5.4.

Figure 94. shows the settings for the Operation Settings tab:

e Choose Program and Verify so that the Secure binary can be programmed and verified.

e Choose Program Flash Option and Verify Flash Option so that the TrustZone boundary and device
lifecycle state can be set up and verified.

e Erase is not selected as this has been taken care of with the Initialize command as shown in section 6.1.

File Target Device Help

Operation| Block Settings Fash Options Connect Settings Unique Code

Command Erase Options
[ Erase Erase Selected Blocks v
Program Program & Verify Options
Very [[] Erase Before Program

Verify by reading the device

Program Flash Options
Verify Alash Options

[] Checksum
Checksum Type
RC-32 meth
Fill with OxFF
[] Code Area / User Boot Area Emor Settings
[] Data Area Enable address check of program file

Figure 94. Set up Operation Settings (RFP)

Figure 95 shows the setup for the DLM state transition and TrustZone boundary setup for this example
application.

Note: With RFP, you can directly transition the MCU device lifecycle state from OEM_PL2 to OEM_PL1
without needing to download the dummy Non-secure binary. The dummy Non-secure binary is only
needed for starting Non-secure project development.
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File Target Device

Operation Operation Settings  Block Settings | Plash Options | Connect Settings  Unique Code

Help

v ~

Set Option Set
Target State OEM_PL1
|
v DLM Keys
Set Option Do Nothing
AL2 Key File
AL1 Key File
RMA Kev Eile
v Boundary
Set Option Set
Use Renesas Partition Data File No
Code Secure Size [KB] 32
0
Do Nothing
v Configuration Data Lock Bit v

Figure 95. Setup for the TrustZone Boundary

Settings for the connection interface are shown in Figure 96.

Security Design using Arm TrustZone - Cortex M85

File  Target Device

Operation Operation Settings Block Settings Flash Options |c|ue Code

Help

Communication
Tool: Interface: |2 wire UART Speed: | 9,600 ~| bps
Tool Details... Num: AutoSelect
Device Authentication
Settings ...

Figure 96. Setup for the Connection

Select the Secure project binary (. srec or . hex) generated in to be programmed into the MCU. Select the

binary generated from section 5.4.1.2.

File Target Device Help

Operation IOperatlon Settings Block Settings Flash Options Connect Settings Unique Code

Project Information
Cument Project:
Microcontroller:

pre_programmed_sensor_algorithm_s mpj
R7FASBM1AHECBD

Program and User Key Files
l d_dummy_ns_project\pre_programmed_sensor_algorithm_s\Debug‘pre_programmed_sensor_algorithm_s sred.’l
CRC-32: 83F4D397 Add/Remove Files...

Command

Program >> Verify >> Program Flash Options >> Verify Flash Options

Start

Figure 97. Select the Secure Binary to Program into the MCU

With all settings in place, click Start to download the Secure binary and set up the TrustZone boundary.

6.3 Download the Non-secure Binary

Use RFP to download the Non-secure project binaries using the provided RFP project:
\RFP projects\pre programmed sensor algorithm ns\pre programmed sensor algorithm

_ns.rpj.
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Check Program Flash and Verify Flash, uncheck Program Flash Option and Verify Flash Option from
the Operation Settings tab.

File Target Device Help

Operation ock Settings Flash Options Connect Settings Unique Code

Command Erase Options
[] Erase Erase Selected Blocks v

Program Program & Verify Options
Verify [[] Erase Before Program

Verify by reading the device
[] Program Flash Options

[[] Verify Flash Options

[] Checksum
Checksum Type
CRC-32 method
Fill with OxFF
[] Code Area / User Boot Area Error Settings
[] Data Area Enable address check of program file

Figure 98. Operation Settings for Non-secure Project Binary Download

Transition to DPL is not selected. Change from Do Nothing to Set in production flow. Once the device
lifecycle state is transitioned to DPL, the JTAG interface will be disabled (no SEGGER RTT Viewer
input/output functionality).

Operation Operation Settings  Block Se'ctingsl Fash Options Fonnect Settings Unique Code
v DLM A
Do Nothing
OEM_PL2
Set Option Do Nothing
AL2 Key File
AL1 Key File
RMA Key File
Boundary
Set Option Do Nothing
Us Partition Data File No
Yy
Set Option Do Nothing
ze Com No
No
Dis au No
Disable LCK_BOOT transition No
v iguration Data Lock Bit v

Figure 99. Operation Settings for Non-secure Project Binary Download
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The Connect Settings should use the same setup as shown in Figure 100.
Select the Non-secure binary generated from section 5.4.2.2.

File  Target Device Help
Operation  QOperation Settings  Block Settings Flash Options Connect Settings  Unique Code

Project Information

Cument Project: pre_programmed_sensor_algorithm_ns.mj
Microcontroller: R7FASBM1AHECBED

Program and User Key Files

on_secure_project'\pre_programmed_sensor_algorithm_ns\Debug'pre_programmed_sensor_algorithm_ns.srek

o
CRC-32: 58B282DD Add/Remove Files...

Command

Program >> Verify

Start

Figure 100. Select the Non-secure Binary
With all the above settings, click Start to download the Non-secure binary.

The production flow of the IP protection use case also requires advancing the device lifecycle state from
OEM to LCK_BOOT. However, once the device lifecycle state advances to LCK_BOOT, the serial

programming interface will be permanently locked. To avoid accidental MCU debug and serial programming

interface locking, do not transition the device lifecycle state to LCK_BOOT unless you are doing so for
production usage.
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6.4 Specific Instructions to Support IAR EWARM Development Path

6.4.1 IAR l-jet and TrustZone Partition Boundary Setup
IAR’s I-jet debug probe does not provide support for setting the TrustZone partition boundaries, as it does
not have the ability to interface with the RA MCU’s boot mode through the debug header.

It is therefore necessary to set the TrustZone partition boundaries appropriately using alternative means
before debugging through I-jet. Typically, this will need to be done using an SCI connection to the
board/MCU and the RFP application available from:

https://www.renesas.com/us/en/software-tool/renesas-flash-programmer-programming-gui

Figure 101. shows RFP configured to read the TrustZone partition boundaries from a . rpd file.

File  Target Device Help

Operation Operation Settings Block Settings Flash Options  Connect Settings Unique Code

v DLM A
Set Option Do Nothing
Target State OEM_PL2
v DLM Keys
Set Option Do Nothing
AL1 Key File
v  Boundary
Set Option Set
lUse Renesas Partition Data File Yes
stzone\IAR\sensor_s\Debug\Exe\sensor_s rpd..
v Security
Set Option Do Nothing
Disable Initialize Comr No
Disable AL2 authent No
Disable AL1 authentica

isable LCK_BOOT transition
v Configuration Data Lock Bit
Set Option Do Nothing V)

Figure 101. Configure TrustZone® Partition

6.4.2 CMSIS-DAP and Trust Zone Partition Boundary Setup

EWARM also supports the use of CMSIS-DAP based debug probes. These do not have the ability to
interface with the RA MCU’s boot mode through the debug header.
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7. Appendix B: Glossary

Term Meaning

OEM Original Equipment Manufacturer.

AL Authentication Level.

RSIP Renesas Secure IP: An isolated subsystem within the MCU protected by an Access
Management Circuit. Performs Cryptographic operations.

o
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9. Website and Support

Visit the following URLSs to learn about the RA family of microcontrollers, download tools and documentation,
and get support.

EK-RA8M1 Resources renesas.com/ra/ek-ra8m1l
RA Product Information renesas.com/ra
Flexible Software Package (FSP) renesas.com/ra/fsp
RA Product Support Forum renesas.com/ra/forum
Renesas Support renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.

Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Viu (Min.).
Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LS| is not guaranteed.
Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a
system-evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Notel)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
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